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1. Nuclei Studio IDE /5%
1.1. Nuclei Studio IDE f%j4\

— R AT X35 (Integrated Development Environment, IDE) X-FAF 4]
MCU #RAF4E% B, IR R EMEB) IDE 37 SEBr I H PR 5. ARM 15
IDE #f Keil, &5 B KRR 2 A\ O TARIM R AR 4% . A2k IDE # CEin
Keil) fAAEHRBLLL U ZR AR, %K MCU | it B ORI %2t IDE 4L fEH, Ea
Hib% ) e2studio A1 NXP f LPCXpresso 2%, X4t IDE #4237 Eclipse #£42, Eclipse J1
SR T PR % % MCU IDE () 3:9ii%#%. Nuclei Studio IDE 1EZ:853k /A, 3T MCU Eclipse
IDE F¥ A ) — 3R BT RFE K 2 7 A3 88 4% b AR O 3R B T AL

Eclipse 1 &5 KT GBS AGE 1, IR I ALV aNE (R BIANED) DLk e akok
AAUH]. Eclipse A& & —MEZF&, Br T Eclipse “F & BT WIZZ 46, HBTA DhRe L
TARFHEE . PR NREEAIEE Eclipse W H (A RS F R T G DR, Bl FH HABIT &
N SRBEIEAE . — ST DR S — Nl AT Se B KRR E I S A

Eclipse IDE - & H & LA R JUJ5 T (8%
XK

Eclipse H 2001 FHEH DK, IR IX, XN N4t 72 otls, O
K45, BRI G, LAt TR Eclipse “F &5 T B3R T/ER % .. Eclipse “F & AlAH
KIH . 1 EH e B eclipse.org Ml T #3R15

m RRaEut

Eclipse (I BEIEACHS T & 7 T RN SRS 78 70 RAE R IIBL BHIR 1% . Eclipse £
AN ZANIUH AWt

® -VEUiH——MIE T Eclipse A&

® CDT UiH——M=ET C/C++H KT H.
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® PDE 1 H ——{ & T4l T K5
LI EPIR

B A R RE IR IRACRS, BREBIE LRI R, EReMBIs N R W anE, AE
FERIIE R TAF

o OREEE

Eclipse ‘-6 XM Java i 5 %5, W 1E Windows 5 Linux 22 FIF & TAEws B4 . JF
IS T HSCREZ MRS . 2 PE RS FI BE.

m Ay

Eclipse RPN AT fE4EH, ERef 5 ClearCase. SlickEdit. Rational Rose LA K&
b —@BHES (UML) EEE =771 BRI FETE. b, Bibn 5 &MEEH - #E O
(GUD 4B a8 thlml TAE, I 3CRF& MG

Nuclei Studio 24787755 Nuclei SDK ¥4, 584:iiii &2 SDK R 2L, Al LAJS (PRI T A%
WRCAE, e TR EED. ANE Nuclei SDK VAT, FIARIERINR 7 K B 2his .

1.2. Nuclei Studio IDE F#;;

N HER P PuE B R, A SORYHERR A R PiSe # E#E 47 1Y) Nuclei Studio IDE 044 & 4662
ORA T BB Z AR50 P AR R AT ML, Bk A
https://www. nucleisys. com/download. php, UIE 1-1 7N,

FA P A] DAAE RS SR B A T b ) “ REgbhty” , WIEH PR, FE6 N Windows B
Linux [ NucleiStudio E4if (GERE: CORBHA B MG N #Eb 0, HABRSARER, HP
5 B AT 2B FH o R AN Bk 4 FH M AT A

H i C. 7€ Win 10 64 7 £%, Ubuntu 18.04/20.04 fil Redhat7.6 64 A7 A _FIGAEMR, HE
T A LLERRA T R 45
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CRIERHE

RISC-V GNU Toolchain Nuclei OpenOCD

3 Windows v 3 Centos/Ubuntu x86-64 A~ 3 Windows x86-32 oV 3 Linux x86-64 v

Windows Build Tools Nuclei Studio IDE

3 Windows 3 Windows x86-64 v 3 Linux x86-64 ¥

¥ Nuclei Studio User Guide ¥

& 1-1NucleiStudio IDE kALK T4k S

1.3. Nuclei Studio IDE %3

2 5¢ i NucleiStudio IDE 48 446 N2, 5 G5 T3 anE 1-2 (FREEH AT
BEHRD , SRINEIT

B  NucleiStudio # 4

® ZHMETHE I Nuclei Studio IDE HJ# . & BHAKMA LA T RES A
T S8

7/

B HBird Driver.exe (2021.02 fRAS#A B4
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® N Windows JR#RHE, I ytRig 54 1 USB SR80 2 3.

® 7t Windows 85T, RZHRSSN, T2 IKG) 1% USB W& REWH R4t

P
® T 2021.02 iAH HEH ) openoed 51 N T AIKTHE
B SerialDebugging Tool (2021.02 RAEA ML)

® X Windows [R$ft, b 0y eh DHEB 78k e mT AT Ja SR
A i R R T EE R .

Data (D:) » NucleiStudio IDE 202102-win64 »

s

B &Pt HEA it Fh
NucleiStudio 2021/2/2 10:44 e

1-2NucleiStudio IDE &4 301N 2

2. J83h Nuclei Studio
J5 5 Nuclei Studio IZE SR (windows A1 linux 42 fE 40 F#/E) -

B H X NucleiStudio IDE X474 NucleiStudio SC4H 32 K i B mT $047 3044, BITT 3 5
Nuclei Studio, @ 2-1 i~

B 55— k)55 Nuclei Studio J&, &5 X iEHEE R 15 B Workspace HF#42, 1% H ¥
TS S8 M H TR, e 2-2 Fik.

B KB4 Workspace HX2 J5, #ii “Launch” %4, ¥ % )53) Nuclei Studio. 55—
& 215 1 Nuclei Studio AWK 2-3 Frx.

B 2021.02 fiR& Nuclei Studio 2XiA>%</H T Launch Bar, 28R 8.1 78 Nuclei
Studio # 1] Launch Bar ZhgE, 518 Pd 4 A A T £
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Data (D:) » NucleiStudio IDE 202102-win64 » NucleiStudio
EFR ZHEs Eitl F
configuration 2021/2/2 10:44 prg iz
features 2021/2/2 10:44 prgla=>c3
jre 2021/2/2 10:44 S
p2 2021/2/2 10:44 S
plugins 2021/2/2 10:44 BVE S
readme 2021/2/2 10:44 itk
toolchain 2021/2/2 10:44 prglisyes
tools 2021/2/2 10:44 prglisaes
] artifactsxml 2021/2/2 10:35 XML 324t 213 KB
ecli-psec.exe Click Here 2021/2/21032 R FRRER 127 KB
Q notice.html 2021/2/2 10:32 QQBrowser HTML ... 10 KB
= Nuclei Studio User Gui e.pdf 2021/2/2 10:37 Adobe Acrobat Do... 8,129 KB
I@ NucleiStudio.exe I 2021/2/2 10:32 MNFHER 408 KB
&+ | NucleiStudio.ini 2021/2/2 10:32 [i=1ia— 1 KB
=] Ver.2021-02.txt 2021/2/210:37 AR 0 KB
2-1 Wi “NucleiStudio.exe” &z Nuclei Studio
@ NucleiStudio IDE Launcher X

Select a directory as workspace

NucleiStudio IDE uses the workspace directory to store its preferences and development artifacts.

Workspace: | [C:\Users\24954\NucleiStudio workspace}

Browse...

[ Use this as the default and do not ask again

2-2 ¥ E Nuclei Studio ) Workspace H3x
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@ CPDE - NucleiStudio o
File Edit Source Refactor Navigate Search Project Run RV-Tools Window Help
= &Welcome

SHNudeiStudio  Welcome to the NucleiStudio for C/C++ Developers

Open a file from the filesystem [ Aiways show Welcome at start up [\s

K 2-3 % —&J23) Nuclei Studio Ft1fi

3. Nuclei Studio ThEENE

Nuclei Studio H 2021.09 /)5, ¥ IDE 5 Nuclei SDK 45, H /7 Z4# H Nuclei Studio 7
Jeke s BLH Nuclei SDK 0,22 £l IDE o, 5 FTARYE AN [A] T A AR DR BT AN R OB TR, JF
AR AN [F) A ASCAN IN 75 22 1) SDK YA, AR ¥ B T0AE AN [R] H 2 PEBE R R TR . AR T AE
RVSTAR FFAHR L, PO RIZR GD32VF103 () TA A HIHRIE /44 Nuclei Studio JifE, T4
MBS HZJFH &R,

B OE MR HIE T 2 Nuclei SDK WA, H AT RIZHEH SDK 1
Nuclei_ SDK.zip #il Hbird_SDK.zip, 4§ & Wi K& A0 R ) zip £

B Nuclei SDK F##hlik: https://github.com/Nuclei-Software /nuclei-sdk

B Hbird SDK F#hht: https://github.com/riscv-mcu/hbird-sdk
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¥ dev_nuclei_next - ¥ 7branches 1tag Go to file m

‘ fanghuaqi doc: update documentation ... (] Clone ®

HTTPS GitHub CLI

-github/workflows ci: Update for different boot mode https://github.com/Nuclei-Software/nuclei [}

buildroot @ 2665fb0 module: bump submodule version | Use Git or checkout with SVN using the web URL.

conf doc: update decumentation
[,‘,J Open with GitHub Desktop

freeloader @ 85ed8c0 submodule: change payload offset

linux @ 70e1148 linux: Fix linux nuclei gpio driver [?) Download ZIP

opensbi @ 3ce5%a submodule: change payload offset to 0x200000 4 months age

u-boot @ 7b67780 submodule: change payload offset to 0x200000 4 months ago

K] 3-1 % SDK [ zip fL

B4 NERBK sdk [ zip £12 % #) Nuclei Studio #1, 7ESEHAL%ESE “RV-Tools-->Nuclei
Package Management” 7£3 ! f] Nuclei Package Management & P T $ 4T 5 N #1E, &

£ T E) Nuclei_SDK.zip S AL RN 3-2. A LILE Nuclei Package

Management ‘& 3 5T AT AH ¢ SDK AL MBS -

& NucleiStudio_workspace - NucleiStudio IDE

File Edit Source Refactor Navigate Search Project Run |RV-Teols | Window Help

To add a project NMSIS Documentation

@ New Nuclei RISC-V C/C+ + Project

Create a new Makefile project in a directory
y eats

Containing existing code
[€) Create 2 new Cor C++ project

[ Create a project..
iy Import projects...

[2) Problems 1 Tasks Bl Console £ [ Properties 4 &[S G R
CDT Build Consele ftest1]

@ | [ No Launch Configu @ DK Configuration Taols ctrl+6 = S R D e BB E S @ O ORI SO

N R
= Nucle: System Technology Homepage
& Project Explorer 12 BE%Y § =0 Nuclei Studio User Guide = O % Outiine ¥ @ BuildTargets & § = O
There are no projects in your workspace. Nuclei SDK Documentation There is no active editor that provides an outline.

& @-08-=0

3-2 j#: A\ SDK Manage

AR N E RSO G RBHOM KA, REURBHRE I, AR sl e A2 A i sl A

T 15
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@ NucleiStudio workspace - NucleiStudio IDE

File Edit Source Refactor Navigate Search Project Run RV-Tools

- o x
Window Help

- | [No Launch onfigurations ~Joni |- V3N -E® LD B OE S G B0 B ®E P
H-fl-ooe-2-|m Qi |E
(25 Project Explorer &0 BSY § =0 = B 5=outine 2 @BuidTargets & § = O
There are no projects in your werkspace.

There i no active editor that provides an outline.
To add a project:

& Nuclei Package Management - o X
€ New Nudlei RISC-V C/C++ Project
s Cicete 2 new Mokefie projectin o directory | | Nuclei Packages
containing existing code
N: Si Stat, Owr Ds
Create a new C or C++ project ame ze ats ner il
9 Create a project.
R Import projects.
oG EBEEAlre-no-=-0
< >
View log
L]
3-3 FARBEE
< AR 72
@
Fle Edit Source Refactor Navigate Search Project Run RV-Took Window Help
&0 |= * || No Launch Canfigurations ~ | om | -n v md B R~ Dt RO E ST GG B0 LIS
P~F D oD~ a ®|&E
& Project Explorer 1 %7 8 =0 = O % Ouline ! @BuldTarges & § = O
There are no projects in your workspace. There is no active editor that provides an outline.
To add a project:
© e Nuckl RISEY CCs s Drofecy I8 Nuclei Package Management - o by
Nuclei Packages
Name Size Status Owner Dascrip)
- B w [ Scftware Development Kit
Creste s project.. O sckonuceisdk
i Import projects... [ 0:3.4-dev rsemve [ nuclei Muclei N/NX/UX Embedded

2EE&#e--=0

N

i

View log

K 3-4 Bt E

B A AR, WS T, % “File --> New --> New Nuclei RISC-V C/C++

AR N E RSO G RBHOM KA, REURBHRE I, AR sl e A2 A i sl A i 16
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Project” , 1 P 3-1. A LATE Project Explorer #1 K H %+ “New Nuclei RISC-V

C/C++ Project”

B Nl

File | Edit Source Refactor Navigate Search Project Run RV-Tools Window Help

New AIEFSHIEN S| @ New Nuclei RISC-V C/C+ + Project -
Open Fil [ Makefile Project with Existing Code
e =
Recent Files > 9 Project
Cctrl+w Convert to a C/C++ Project (Adds C/C++ Nature)
Cirl+ShiftsW 6% Source Folder

[ File from Template
@ Class

=]

- o x

MERNRA HORSRE-RArEN AR 20 R U el T--

Q s|[@

5% Outline 2 @ Build Targets & § = O

There is o active editor that provides an outline.

7 Rename. r |03 Bamee
&) Refresh F5 [ Other ctlsN
Convert Line Delimiters To >
Print, cisp
g Imp
4 Exp
Properties Alt+E
Switch Waorksp:
Restart
Edt
[£ Problems 2 ] Tasks & Console [ Properties Y 8§ =08
0items
Description . Resource  Path Location Type
a
-y VA
K 3-5 i s A el i e
— ~
fle Edit Source Refactor Navigste Search Project Run RV-Took Window Help
40 | = No Launch Configurstions v on v M- - ~Blw BO G-~~~ G H5-0-9 - Q-5 4~
Q &
O 8¢ Outiine 12 @BuldTargets w § = O
There ix no active editor that provides an outine.
£ Problems 12 & Tasks [ Console [ Properties
0items

Description Resource  Path  Locstion Type

& 3-6 M Project Explorer &I H

B P 3-8 Fin, TEFRHAIE DRl UANFE) B AL A FRICA B SDK, % = — Board
T K SDK,E #4655 SoC & Board B4 . iX H L RVSTAR &R 6, Frblix —miik

ARSCAE PR A BRI SR B T, REERBHCR e P al, APHER. S HI sl A SO 2 2 sih o N . Wi 17
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# “GigaDevice->GD32VF103->Nuclei GD32VF103 RVSTAR Board->sdk-
nuclei_sdk@o.3.2-dev” . &ii “Next” #EANF—.

E Creating Nuclei RISC-V C/C++ praject O b

Create Nuclei project

Please choose the right development board

~ Nuclei Details
v Nuclei FPGA Evaluation Demo SoC
v Nuclei FPGA Evaluation Board
sdk-nuclei_sdk @0.3.4-dev
v GigaDevice
v GD32VF103
v Nuclei GD32VF103 RVSTAR Board
sdk-nuclei_sdk @0.3.4-dev
+ Sipeed Longan Nano Board
sdk-nuclei_sdk @0.3.4-dev
v GD32VF103V-EVAL Board
sdk-nuclei sdk @0.3.4-dev
v LILYGO TTGO T-Display-GD32 Board
sdk-nuclei_sdk @0.3.4-dev

@ < Back Next > Finish Cancel

3-7 PRSI KA

BN BRI E A E A 3-9 Fron, I8 RVSTAR 1IN #Z A2 [ 2 1) N205,  HX R
arch Al abi 4372 rv32imac # ilp32, FTLL Core i AGEE M. [FFE, RVSTAR FF A
WAX S FF—Ff FLASHXIP F##% X, ATl DOWNLOAD X —i& Wit AN Refs k. A

ARSCAE PR A BRI SR B T, REERBHCR e P al, APHER. S HI sl A SO 2 2 sih o N . i 18
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“Finish” S TFEG

) Creating Nuclei RISC-V C/C++ project m] X

Create Nuclei project

Please select the relevant configuration item

Project name: ‘tes\i
Project Filter by: no filter ~ Filters: ~
Project Example: Coremark Benchmark @app-nsdk_coremark ~
Toolchain: Nuclei GNU Toolchain ~
Nuclei ARCH Extensions: Bitmanip Extension

Packed SIMD Extension

Vector Extension

Download/Run Mode: ILM download mode, program will be download into ilm/ram and run directly in ilm/ram ~
Select NMSIS Library: No NMSIS Library used ~
Standard C Library: newlib nano with printf float ~
Nuclei RISC-V Core: N307FD Core{ARCH=rv32imafdc, ABI=ilp32d) ~
Select Benchmark Options: Options for Nuclei 200/300/600 Series ~

(@' < Back Next = Cancel

3-8 MEFRRE AR L2 AH OG5 B

® Nuclei Studio A PR A A i) TAEBARAS A [ () SDK Y565, 4140 FreeRTOS #HR
TAESUIIXTRLE) OS W%, Demo_dsp ARk T#2 0] LAY Il NMSIS . kT
NMSIS #4115 HiE 2% (https://doc.nucleisys.com/nmsis/index.html) . X H DL
Demo_dsp N, “Project Example” 14% “baremetal _demo_dsp” . K AfEH
dsp T#¢, FFZEAHM NMSIS &, JirLl “Libraries” &4 “NMSIS DSP” .

® Nuclei Studio A AR #r TR f) e T H 2 3 & TAR R, X Bk £ Al
HATEL, Frbl “NEWLIB” i%£#% “newlib-nano without float” . ZwiFfiib %%
“Optimization Level” ## “Optimize more (-02) ” . ZJ5i—Hik#F “Next” H
#| “Finish” .

ARSCAE PR A BRI SR B T, REERBHECER S T, AHERE. SR s i A S 2 il oy WA HHE 19
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B Nuclei Studio A PAPREME S AR BIE DT B i TR Kl 3-10 A, i ZiE
M TREA, AET AR, %8 “SDK Configuration Tools” 13 B ik T H. .
K 3-11, WARBEESGIEALTES, B2k “Optimization Level” 4 “None (-

00) 7, mili “Save” BHUEI. WK 3-12 BRI EEBEUE K TR A T A
SEHL, EFE “clean” JERR— T LR, AT KFrgw1F L 2. SDK Configuration
Tools &5 dm B HC B Ja A IR A AR 15T o B R A &

€ CPDE - RVSTAR_dema_dsp/application/main.c - NucleiStudio - o b
File Edit Source Refactor Navigate Search Project Run RV-Tools Window Help

%][0][=] ©Run IRVSTAR_demo_dsp ¢ o~ B AR BT ON MR ET S TG ETO A AISE A ~flrterox [Quick Access) | = | B8
& Project Explorer 779 @mainc £ Outline
— New > u stdinth
: Go Into : u stdioh
Qpen in New Window e u nuclei_sdk_soch
. u ref convh
Show in Local Terminal W riscy mathh
Copy CtrisC # READ_CYCLE
Paste CulsV | _ get_rv_cycle * " enter_cycle - uinté:
Delete Delete #t le s uint64 t
v gd32vi103 Remave from Context trl+ Alt+ Shift+ Dowr ) o yele : uintbd t
o | Source > e de
Common  Move tyele; o'c uir
RVSTAR demo di  Rename. F2 le; o extra_cost
R 7 «* bench_ercd
Export :::: =8 # BENCH_TRST)
3 # BENCH_INITD
Build Project # BENCH_STARTO
Clean Project # BENCH END{
Refresh Fs \ # BENCH_ERROR()
Close Project Initialized\n"); N # BENCH STATUS(
Clase linrelater] Praje \ # BENCH_FINISH)

Build Targets

51 teet cany inoat £39 A flnal 2

Index >
dsp]
Build Configurations > |
Profiling Tools
Validate
O RunAs >
& Debug As
Profile As
Restore from Local Histo
@ SDK Configuration Tools culte | @
% Run C/C++ Code Analysis
Team
Compare With >
Configure >
Source

Properties Alt+Enter

< >
5 RVSTAR demo dsp

K 3-9 #TJF SDK % & TH

AN PITIR A BB ER BT, RSP R TIRA, AMSAERR . S Sl e A SO 2 A iR sl A T 20
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@) Nuclei SDK Project Configuration

projectName :

Configuration :

Core :

ARCH :

ABI

Tuning :

Code maodel :
Download :

Select C Runtime Library :
Cptimization Level :
Extra Common Flags :
Extra C Flags :

Extra C++ Flags :
Extra ASM Flags :

Extra Link Flags :

Save

SDK Configuration Tools:1.0.0.1

test

Debug

N307FD

[IBitmanipulation Extension(RVE)
] Cryptography Extension(RVK)
[JPacked SIMD/DSP Extension(RVE)
[JVectar Extension (RVV)

| rv32imafdc

lilp32d

Muclei 300 series(-mtune=nuclei-300-5 ~

Medium Low (-mcmodel=medlow)
ILM
newlib nano with printf float

Cptimize fast(-Ofast)

“

“

-fno-code-hoisting -fno-tree-vectorize —ﬂ||

-x assembler-with-cpp

| -WI,--check-sections

Cancel

K 3-10 BN LERE

AR N E RSO G RBHOM KA, REURBHRE I, AR sl e A2 A i sl A
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@ CPDE - RVSTAR_demo_dsp/application/main.c - NucleiStudio - [ul ®
File Edit Source Refactor Navigate Search Project Run RV-Tools Window Help
[Eloi[=] orun I RVSTAR_demo_dsp ¢ o~ Br AL BT DN WP A TETE TG ETOTAYATISS A rflvteroy [Quick Access| || = | &
Pr@ct Explorer ¢ = 8 Emainc = Qutline
~ 1% RVSTAR_demo_dsp 1 #include <stdint.h> ~ , AR o m
Inel Mew L4 u stdinth ~
ape Go lnto . u stdioh
- nuc n u nuclei_sdk_soch
. NMSIS Open in New Window u ref convh
= Core Show in Local Terminal B 4 e mathih
DSP Copy Ciri+C # READ_CYCLE
= Library Paste CtrisV  |get_rv_cycle w'el
v & SoC ® Delete Delete
« & gd32uf103 Remove from Context CtriAttsShift+Down |
Board Source > ‘ ’
Comman Move. le;
RVSTAR demo_dsp.d  Rename 2
N ercd o
'[mp"” =8 # BENCH TRST(
SRt i # BENCH_INIT)
Build Project # BENCH START()
I Clean Project ] © # BENCH_ENDQ
Refresh F5 \ # BENCH ERROR()
Close Project lialized\n"); \ # BENCH_STATUS()
lose Unrelated Project A \ # BENCH_FINISH()
1 8 tect cany inont 3 A flaatid ks
Build Targets » | = I L1

Index > |
Build Configurations [

Profiling Tools >
Validate
© Run As
# Debug As
Profile As
Restore from Local History.
@ SDK Configuration Tools Ctri+6
# Run C/C++ Code Analysis
Team
Compare With

Configure
Source >

Properties AltsEnter

< >
% RVSTAR demo dsp

3-11 V& H TR & B i

4. Q1T H

X B DL & #CAH HummingBird Evaluation Board, #FAfi4bH 8% 4% N N3o7(rv32imafe) N
i, VEZHA 48 Nuclei Studio 812D H 115 W7 2.

f£ Nuclei Studio IDE @& 351 H AT LAAT LU R JURRE W7 3
AR B SR

® X LA fE RN 7, [HETIRE IDE B 2 7T H, Nuclei Studio
B4 7850 # 4 Nuclei SDK. 175 X4 2 O 1 P2 i A B 000 H AR, 18 50 SR B BBk
£

B NEHIHEZSACEYIH -

® XREEH WK, B, M A RRLR O T H SR BT I B, e
BEAT Iy A% HE, I B TR S A s b B N AZIUH , AT DAL g St 61 2 8

ARSCAE PR A BRI SR B T, REERBHCR e P al, APHER. S HI sl A SO 2 2 sih o N . T 22
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T H , R B R B T R B 2.
W OERR T BRI -

o EHREBI N, ZHER T IETIH A, B EFIEE SRS . B
Tz RSB, FrUAESEbs AR R A, (E 2tz R vEgnkfg, AP
AT CAVEGR T A an ] P B 25 R IR TR R AR

B T OHK Makefile @10 H -

o XFh A HEGE AT O 4 K Makefile s HAthZm 3 T BT H, $#24t—F 7 IDE

R i TR, S TA, BRTEN TR, EMESEmEFERGMNEM -, BRI
IDE 3483 .

ORI LR T Ao AT A 4

4.1. BB E3HEIETE

A KA B a3 AR 5 sh 022 H ) 772, 7E Nuclei Studio IDE £l 2 —/Ma ¥ ( Hello
World Wi H, VE4I2PIRUIT.

B OHE AR, WIS, % “File --> New --> New Nuclei RISC-V C/C++
Project” , K 4-1. W 1] PA{E Project Explorer AL # i+ “New Nuclei RISC-V
C/C++ Project” , WK 4-2.

ARSCAE PR A BRI SR B T, REERBHECER S T, AHERE. SR s i A S 2 il oy WA T 23
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2 ek e - o x
File Edit Source Refactor Navigate Search Project Run RV-Taols Window Help
New AlteShiftN > @ New Nuclsi RISC-V C/C1+ Project f - Y IR T rrrs 5
Open File. [ Makefile Project with Existing Cade
- - Q ®|E
S—Operrhro; 7 e 7
Recent Files > 4 Project = B 3% Oufline ¥ @BuldTargets & § = O
Close Editor Curl+W Convert to a C/C++ Project (Adds C/C++ Nature) There is no active editor that provides an outline.
Close All Editors Cirl+Shift+W | 62 Source Folder
Save Culss |G Folder
> .
. i‘ Source File
Save Al Culsshiftrs | [N Header File
P [ File from Template
@& Class
Move..
7] Rename. 2 | Example
& Refresh F5 [ Other.. Cirl+N
Convert Line Delimiters To >
Print. Curl+P
& Import.
i Export.
Properties Alt+Enter
Switch Workspace >
Restart
Exit
[2] Problems 33 & Tasks B Console [ Properties Y § =8
0 items.
Description Resource  Path Location Type
a
B 4-1 AEERAIERE
@ Nudeistudio_workspace - NucleiStudio 10E - o

Fle Edit Source Refactor Navigate Search Project Run

Al|0l|=

L Project Explorer 11

There are no projects in your workspace

| [No Launch Configurations v/ on v g~ - RN I e T

RV-Tools Window Help

#) Problems i1 & Tasks @ Comsole [ Propertes
0 items.
Description Resource Path Location Type

4-2 Project Explorer ¥ EI &2 B

T 8 Outiine 11 ) Build Targets

There is no active editor that provides an outline.

B W 4-3 P, R E O FEREIH KA, X HEEATE Nuclei FPGA R, WiZ&Z&
N307, SDK A nuclei_sdk@0.3.2-dev A KA — NI A&, X %F B Board T )
SDK, M7 “Next” #ANTF—4,

AN PITIR A BB ER BT, RSP R TIRA, AMSAERR . S Sl e A SO 2 A iR sl A T 24
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=]

Create Nuclei project

Please choose the right development board

v HummingBird
~ HummingBirdv2 RISC-V $oC
~ Nuclei MCU200T FPGA Evaluation Board
sdk-hbird_sdk @0.1.3-dev
~ Nuclei DDR200T FPGA Evaluation Board
sdk-hbird_sdk @0.1.3-dev
~ HummingBird RISC-V SaC
~ Nuclei HummingBird Evaluation Board
sdk-hbird_sdk @0.1.3-dev
w Nuclei
~ Nuclei FPGA Evaluation Demo SoC
~ Nuclei FPGA Evaluation Board
sdk-nuclei_ sdk @0.3.2-dev
v GigaDevice
v GD32VF103
v Nuclei GD32VF103 RVSTAR Board
sdk-nuclei_sdk @0.3.2-dev
w Sipeed Longan Nano Board
sdk-nuclei_sdk @0.3.2-dev
v GD32VF103V-EVAL Board
sdk-nuclei_sdk @0.3.2-dev
~ LILYGO TTGO T-Display-GD32 Board
sdk-nuclei_sdk @0.3.2-dev

)
(‘3/.

Details
SoC: Nuclei FPGA Evaluation Demo SoC
- Vendor: Nuclei
- description: Nuclei Demosoc Support Package
- core_vendar: Nuclei
- website: Click to view the details

Click to view the details

- usermanual: Click to view the details

BSP: Nuclei FPGA Evaluation Board
- Vendor: Nuclei
- description: Nuclei FPGA Evaluation Board Support Package
- website: Click to view the details
- sch: Click to view the details
- usermanual: Click to view the details
- extra documents:
- MCU200T SCH: Click to view the details
- DDR200T SCH: Click to view the details
- Video Introduction For MCU200T Board: Click to view the details
- Video Introduction For DDR200T Board: Click to view the details

< Back Next > Finich Cancel

B 4-3 AL E R

W 4-2 R, EFEIIE DR BOE W N 24

Project name: TiH 4. XHE K EN “1_helloworld”

Project Example: 1% Helloworld.

Toolchains: F/1{# H Nuclei GUN Toolchain.

T N2 N3o7, Frbl “Core” & “N3o7” .

e S P AR R =R TR, BUT SRR T8 R A, X B RA T ILM A%

o

B ILM FEEREFESEE FE4E MCU /1) ILM 1, 3M ILM JFa$47. ILM
B SRAM @ik, &=HHEER,

B FLASH T #sA8 7 AR B ) B 1k 20 O Flash X [A], 4AXHRS B )32 i ik 24

ARSCAE PR A BRI SR B T, REERBHECER S T, AHERE. SR s i A S 2 il oy WA Wi 25
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WAL ILM bk X [],  EORE TR PR B 3% T 3/E MCU i Flash 1, {H2 EH
Ja EEE G SRR A BRIZE] ILM F1, 285 W ILM T IRHAT . TR P Rike
HAE Flash #1, Ao ER.

B FLASHXIP N80k 7 AU BLZ) R Flash [X[H], EWREFEFFRAELR N EAE
MCU [f] Flash ', FFHE#M Flash JFHGHAT . P #E S E Flash i, Ao
P

® A %I n] DAL G HEAT L B

® {ii“Finish”5¢ i LREE 2L .

) Creating Nuclei RISC-V C/C++ project [m} X

Create Nuclei project

Please select the relevant configuration item

Project name: 1_he||owor\d|

Project Filter by: no filter ~ Filters: w
| Project Example: Coremark Benchmark @app-nsdk_coremark w

Toolchain: MNuclei GNU Toalchain ~

Nuclei ARCH Extensions: Bitmanip Extension

Packed SIMD Extension

. B
Vector Extension

<=

Download/Run Mode: ILM download mode, program will be download into ilm/ram and run directly in ilm/ram
Select NMSIS Library: No NMSIS Library used w
Standard C Library: newlib nano with printf float w
MNuclei RISC-V Core: N307FD Core(ARCH=rv32imafdc, ABI=ilp32d) ~
Select Benchmark Options: Options for Nuclei 200/300/600 Series ~

@' = Back Next = Cancel

ARSCAE PR A BRI SR B T, REERBHCR e P al, APHER. S HI sl A SO 2 2 sih o N . i 26
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4-2 Fre i H R AR L R

B 4-3 P, IR B 36 Hello World i H 248 58 .

]  workspace - 1_hellowaorld, c- IDE
Fle Edit Source Refactor Navigate Search Project Run RV-Tools Window Help

[&][0][®][0run || 1helloworid debug qems v 1| [+ | B-R-B DS BOE - B - -G H-0-G-Q- @ [ BE

Q eS|

B-fl-vwe-o-m
[ project Explorer 53 = B [8mainc X = B gz Outline 52 (© Build Targets =8
SK-Sr i 1 b/ see LICENSE for license details. ~ PELR o 4 8
% 1_helloworld 2 #include <stdio. U stdioh
- : #include <time.n> o tmeh
< #include <stdlib.n> ime.
5 #include "nucleli_sdk_soc.n” U sdibh
6 U nuclei_sdk soch
7% void print_misa(void) © print misa(void) : void
L # RUN_LOOPS
CSR_MISA Type misa bits = (CSR_MISA Typs) _ RV_CSR_READ(CSR MISA); # RUNLOOPS
1 static char misa_chars[30]: P
S © main(void) : int

©ints_t index = 0:
if (misa_bits.b.mxl == 1)
misa_chars[index++]

misa_chars[index++] = '2';
} else if (misa bits.b.aml == 2) {
misa_chars[index++] = '6';
misa_chars[index++] = '4':
} else if (misa bits.b.mxl
misa_chars[index++]

misa_chars[index++]
misa_chazs[index++]

if (misa bits.b.i) {

misa _chars[index+:] = 'I':

if (misa_bits.b.m) {

misa_chars[index++] = 'M';
¥
if (misa_bits.b.z) {
misa_chars[index++] = 'A':
1 ¥
2 if (misa_bits.b.b) { v

¥ §=8

# Problems 2 | Tasks & Console [T Properties
0 errors, 1 warning, 0 others

Description Resource  Path Location Type

& Warnings (1 item)

| writable | smart Insert |1:1:0 |

Bl 4-3 5 ptR 81 1 H

B AL E A S A “Project—> Build Project” mf “ (8 ek, SRorhi%I E kAT
Dk, JmIEIEUIE 4-4.

AR N E RSO G RBHOM KA, REURBHRE I, AR sl e A2 A i sl A Wi 27
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=] iStudio workspace - 1_helloworld/applicati in.c - istudio IDE - o X
file Edit Source Refactor Navigate Search Project Run RV-Tools Window Help
[&][e][8] @fn | [ 1ot debug qems v 0] (- H G 88RO CBOE B E-G H 0B @E - AFE T
Hr-FH-CPorD A o 3|
&5 Project Explorer & =8 = O 5= Outline 52 @ Build Targets = g
B% Y & AzTails. ~ FEERY o % §
1% 1_helloworld U stdioh
s #include ctime.n> P
4 #include <stdlil & timeh
5 #include "nuclei_sdk_soc.h” U sulibh
6 o nuclei sdk sach
79 void print_misa(void) © print misa(void) : void
{ # RUN_LOOPS
CSR_MISA Type misa bits = (CSR MISA Type) _| RV CSR READ(CSR MISA);: # RUN LOOPS
static char misa_chars[30]: void) i
iinte ¢ indsx = 57 ®  main(void) : int
if (misa_bits.B.mxl == 1) {
misa_chars[index++] = '3';

misa_chars[index++] =
} else if (misa bits.b.mxl
misa_chars[index++] =
misa_chars[index++] =
} else if (misa_bits.b.mxl
misa_chars[index++] =
misa_chars[index++] =
misa_chars[index++] =

if (misa_bits.b.i) {

i charatindeees] = 170
[2] Problems ] Tasks [ Console 52 [ Properties & &[5l A ER #B8-5-=8
CDT Build Console [1_helloworld]

Invoking: GNU RISC-V Cross Create Flash Image -
riscv-nuclei-elf-objcopy -0 ihex "1 _helloworld.elf" "1 helloworld.hex"

Finished building: 1_helloworld.hex

Inveking: GNU RISC-V Cross Create Listing
risev-nuclei-elf-chidump --all-r nangle --line-n —-wide "1_nelloworld.elf" > "1_helloworld.lsc!
Finished building: 1_helloworld.lst

Invoking: GNU RISC-V Cross Print Size
riscv-nuclei-elf-size --format=berkeley "1_helloworld.elf"
text data bss dec hex filename
25998 560 2250 28848 70b0 1_helloworld.elf
Finished building: 1_helloworld.siz

11:33:16 Build Finished. 0 errors, 0 warnings. (took 53.535ms)

Writable Smart Insert 9:48:193 S

4-4 5T A 5

B UK 4-5 o, {E Hello World 5 H B34 Bad #29r,  Hox M) OpenOCD ft & CL & [A]
A, EWHMIETEE, AP UAS A H SR “Hello World” , sl
“Debug As —>Debug Configurations” Jf /& AL & k21T & H . Debug 5 Run f#
FAAR A F B & S, ATl “Run As —>Run Configurations” 17

AN PITIR A BB ER BT, RSP R TIRA, AMSAERR . S Sl e A SO 2 A iR sl A T 28
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@ CPDE - 1_helloworld/application/main.c - NucleiStudio

- 9 x
File Edit Source Refactor Navigate Search Project Run RV-Tools Window Help
&|[0][=] ©Run + @1_helloworld_debug o~ B A A GOSN A ST e v O TR ATINE SISy LR [Quick Access] | = | B
& Project Explorer = =&le 770 @mainc £ Outline s ild Tar... Docur
~ & 1_helloworld e Tt pense details. X vEARV e
 Binaries u stdioh
 Includes Celkno 4 timeh
« & application Open in New Window oc.h® u stdiibh
4 maine Show in Local Terminal > u nuclei_sdk soch
& Debug o print_misafvoid) - voicl
- &nudel sdk | 'C‘TW ‘cwf = main(yoid) : in
: _bits = (CSR_MISA_Type) __RV_CSR_READ(CSR_MISA);
NMSIS % Delete Delete  [hars[30];
SoC ; - . B
Remowe from Context Ctrl+Alt+Shift+ Down
Thelloworld ¢ g0 o Sk e 11
Move lex++] = '3°;
s ax++] = "2
Rename. F2 §ts.b.ma
& Import. ex++] = 6’
Export.. exit] =
ts.b.mxl
Build Projects exet] = ©
Clean Project “::] =2
Refresh pg fexel =
Close Project
Close Unrelated Project ex++] = 'I°; v
Build Targets > B
Index > _ e . LU
Build Configurations >
rld. elf o
Profiling Tools > B ees Linker
Validate h=rv32imafc -mabi=ilp32f -mcmodel=medany -msmall-data-limit=8 -02 -ffunction-sections -fdata-sections -fno-common -g -T "D:\CPDE\1_helloworld\nuclei_sdk\SeC\hbir
Run As 5 | 1_helloworld.elf
3| @ 1C/C++ Container Application
Profile As > [ 2 Local C/C++ Application } owor1d. hex"
Restore from Local History... Debug Configurations...
@ SDK Configuration Tools Clil+6 o
4 Run C/C++ Code Analysis Create Listing . .
. , r-source --all-headers --demangle --line-numbers --wide "1_helloworld.elf" > "1_helloworld.lst"
bworld. 1st
Compare With »
Configure Print Size
5 rmat=berkeley "1_helloworld.elf"
Source 51 dec  hex filename
" 1le134 2796 1_helloworld.elf
Properties . AltsEnter | 0% ei
20:86:52 Build Finished. @ errors, 8 warnings. (took 35.629ms)
v

1 helloworld ]

K 4-5 JF )5 iR Bl & ik

B W 4-6 fior, AT AR ECE X “Hello World_Debug_OpenOCD” .48 H 5
AR T PSR R 28 454 OpenOCD #EAT F#AIERKI /1%, ATUEES 6
TRHAT TR T AR

AR N E RSO G RBHOM KA, REURBHRE I, AR sl e A2 A i sl A TR 29
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@ Debug Configurations O X
Create, manage, and run configurations ﬁ\
EEYEIIEER Name:‘17hech0r\d7debugiopenocd |
type filter text [ Main - % Debugger| & Startup % Source [ Common| % SVD Path
[€] C/C++ Application .
[€] C/C++ Attach to Application loice:
[E1C/C++ Container Launcher ‘LheHowcr\d Browse...
[ C/C++ Postmortem Debugger C/C++ Application:
[€] C/C++ Remote Application ‘Debugﬂ helloworld.elf
Cit C/C++ Unit =
=1 GDB Hardware Debugging Variables... | Search Project... Browse...
v [E1GDB OpenOCD Debugging Build (if required) before launching
El 17he|low0rldideblfgiupenocd Build Configuration: Select Automatically ~
€1 GDB PyOCD Debugging
1GDB QEMU Debugging (O Enable auto build (O Disable auto build
€1 GDB SEGGER J-Link Debugging (® Use workspace settings Configure Workspace Settings...
@& Launch Group
# Launch Group (Deprecated)
Filter matched 14 of 15 items Reverl ATl
@ Close

4-6 H34 A OpenOCD fid &

4.2. NCHETHEES AQIEFH

KA EANABanf i IDE NEF T H BHESACEHTIH, AL N3oy B3 H B N EET
SN, THAENE Chttps://github.com/riscv-mcu/Nuclei-Studio IDE-Project-Package) .
B 4-7 o, @B HEIE SRR,

fE£3ET Windows ] Nuclei Studio IDE JF &I, Wi L H R “ TR FahtldE TR,
AR EINEUE I H B A A nuclei-sdk XY, MCH B SE T —TH BAKNH

[E] README.md Update README.md

[E] nuclei-eclipse_demo.rar update package

4-7 fiF github ETH)35 H 4

ARSCAE PR A BRI SR B T, REERBHCR e P al, APHER. S HI sl A SO 2 2 sih o N . i 30
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# nuclei-eclipse_demo.rar K450 LG, NEWE 4-8 i, 40 008:

FEHR BN HES e

settings 2020/8/5 17:46 pvgl=c

application 2020/8/5 17:46 g ey

nuclei sdk 2020/8/5 17:46 LS
] .cproject 2020/8/5 17:46 CPROJECT 324
| .project 2020/8/5 17:46 PROJECT {4
" | hello_world debug openocd.launch 2020/8/5 18:11 LAUNCH 3244

4-8 EFEIFAMIH

B I H W R#IA SO setting, .project Fl.cproject

B Ui H 8K Debug W E 3 f*.launch
B nuclei_sdk 043k
VS JE TR ARG 4 SDK J5ARAY

B application 4%

SIS hello_world FE4IFE 7 H main B8 HEACHS .

P RATEERIEE, AR

B SRR LR “File—>import” .

B 0 4-9 fius, #EFF “Existing Project into WorkSpace” J&, Al “Next” .

AN PITIR A BB ER BT, RSP R TIRA, AMSAERR . S Sl e A SO 2 A iR sl A R 31
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@ Import O x
Select

Create new projects from an archive file or directory.

Select an import wizard:
type filter text
v & General
& Archive Fil
= Existing Projects into Workspace
3 File System
T Preferences
2 Projects from Folder or Archive
e CfC++
= Git
& Install
& Oomph
& RPM
& Run/Debug
= Tasks
& Team
e TextMate
@ Tracing
&= XML

@ <Back Finish Cancel

K 4-9 AR

B A “Browse” , EFFESARNIHEKSE, WK 4-10 i,

@ Import O

X
Import Projects J;L/
N . N . ’
Select a directory to search for existing Eclipse projects.
(®) Select root directory: H v ‘I Browse... I
(O Select archive file: Browse...
Projects:
Select All
Deselect All
Refresh
Options

[] Search for nested projects

] Copy projects into workspace

[] Close newly imported projects upon completion
[ Hide projects that already exist in the workspace

Working sets

[CJAdd project to working sets New...
Working sets: Select...
@ < Back Next > Finish Cancel

K 4-10 E&#FFHEFAKIH

AR N E RSO G RBHOM KA, REURBHRE I, AR sl e A2 A i sl A T 32
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B HESARIE K8 IDE 35, il “Finish” 41 4-11 fos

& Import O

X
Import Projects ?'::5

Select a directory to search for existing Eclipse projects. 4

(®) Select root directory:l DACPDE\hello_world v I| Browse... |
() Select archive file: Browse...
Projects:
hello world (DACPDE\hello_world) Select All
Deselect All
Refresh
Options

[]Search for nested projects

[ 1 Copy projects into workspace

[ Close newly imported projects upon completion
[ Hide projects that already exist in the workspace

Working sets

[] Add project to working sets New...
Working sets: Select...
@ < Back Next > Finish Cancel

B 4-11 P E S AR IH
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B {f IDE I H BIHEHEBHERFATHPEHRXRESEHWE 4-12 fix. A IHERIAN
N307 HI4mi%1ET, Nuclei SDK 1V 17 helloworld 18 FH 2 0. 7525 £ 1) Nuclei
SDK J56%1% 75 7] Github Chttps://github.com/riscv-mcu/hbird-sdk) FREEIS

v 1= hello_world
il Includes
= application
& nuclei_sdk
= hello_ world _debug openocd.launch

K 4-12 BRI H I SCEg
4.3. THERFIEIRIE

AT A B a8 B 555 RAE Nuclei Studio IDE 61—/ H 1 E 2 X ) Hello World T
H. F &M N HummingBird Evaluation Board, W% A N307. Z 7L T AIETIH 2 4b, 87
BRI E SRR, FAP RN,

4.3.1. FZhANEHME
B 7ESEHRE LR “File—> New —> C/C++ Project” . fKE 4-13 FiR.
B 4-14 PR, EFRBRE O HRGED TS
® Project name: WiH 4.

® Use default location: WIRZJE T ik i, 248 FHERIA Workspace U A7 Ik
TiH .

® Project type: i%£# “Hello World RISC-V C Project”
SR G s Next it N K —2
B K 4-15 fow, fEFRHEE i E Hello World 1 H B34S E..

® ffiffk “Source” WEIIAR A, HIEHD “Next” BENT D,

AN PITIR A BB SR T BT, RSP RS, AR R sl e A SO 2 Al el 2y A W 34
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B 4-16 fon, RS E H B E I H BRI ECE A AT E 1 .

o DA LMEMEMS EAMAEMIZE, HREA L “Next” #HAT D,
W RS R OB E I P 1 RISC-V L H 4.

o UAENE, HEEESE “Finish” , RIE5EMK I Hello World i H #1612 .
B Q5 Hello World T B ST AE 4-17 Fizs.

B HiE— application XFF., WK 4-18, 7& LFEAL 7% FF New —> Folder, #iiA\
application, i “Finish” SEpUH# TR, WE 4-19. K main.c ¥ A application 3
PF R 5E AT 3 3

@ CPDE - NucleiStudio - [« ®
[ )it source Refactor Navigate Search Project Run RV-Tools Window Help

2% @ Erar G it v O R NE § i o [Quick Access|| o | 8
Open File...
. Open Projects from File System.
Recent Files 3 Bl Convert to a C/C++ Autotools Project
. B Convert toa C/C++ Project (Adds C/C++ Nature)
W @ so

Folder

¢ Source File

+ Header File
File from Template

= Project... % Outline
An outline is not available.

n
wrce Folder

© Class
Task
o Example..
F5 [ Other_ cul+N
wert Line Delimiters To

ri+P
Import...
Export..
Properties Alt+Enter

Switch Workspace
Restart
Ext

© Console
Mo consoles to display at this time.

K 4-13 g C/C++ Project

AN PITIR A BB ER BT, RSP R TIRA, AMSAERR . S Sl e A SO 2 A iR sl A T 35
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] O X

C Project =4

Create C project of selected type =

Project name:l 2_helloworld I

Use default location!|
Location: DACPDE\2_helloworld

Browse...

Choose file system: [default

Project type: Toolchains:
GNU Autotools | Risc-v cross Gecf
Executable

@ Empty Project

& Hello World ANSI C Project

& Hello World RISC-V C Project

@ Nuclei SDK Project For GD32VF103 SoC

@ Nuclei SDK Project For HummingBird SoC
Shared Library

Static Library

Makefile project

< >

Show project types and toolchains only if they are supported on the platform

@ < Back Finish Cancel

K 4-14 ¥% & C Project 1 H 4 fli2k &Y

] O X

Basic Settings =~

Basic properties of a project ——

Author ‘

Copyright notice ‘Vour copyright notice

Hello world greeting ‘HeHo RISC-V World!

Source I\ I

Linker other options: ‘

@ < Back Finish Cancel

& 4-15 ¥ & Hello World 1 H [ R AA4Z B,

AR N E RSO G RBHOM KA, REURBHRE I, AR sl e A2 A i sl A i 36
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(&) O X

Select Configurations s
Select platforms and configurations you wish to deploy on o
Project type: Executable
Toolchains: RISC-V Cross GCC
Configurations:

&% Debug Select all
1% Release
Deselect all
Advanced settings...

Use "Advanced settings” button to edit project's properties.

Additional configurations can be added after project creation.
Use "Manage configurations” buttons either on toolbar or on property pages.

@ < Back Finish Cancel

Kl 4-16 WETH KR B AL JE

@ CPDE - 2_helloworld/main.c - NucleiStudio

[« X
File Edit Source Refactor Navigate Search Project Run RV-Tools Window Help
%[0/[=] ORun ) myProj Debug o~ CRE S RA-IRVESE SR R AR XA RS A R AR AN S TR S LR TR R Quick Access|!| |8
& Project Explorer g = 2 EOutline » b "
2 helloworld ~ rEARE e R
# Includes “ stdioh
@ main.c * main(void) : ir
#include <stdio.h>
* Demonstrate how to print a greeting message on standard output
and
s a build-only project. Do not try to run it on a
, since it lacks the dev specific startup
22 main(void)
23 {
24 printf("Hello RISC-V World!™ "\n"); v
ks © Console - 2 Ai®Qvy
CDT Build Console [2_helloworld]
2 helloworld

K 4-17 65k Hello World i H (#) 7t
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@ CPDE - 2_helloworld/main.c - NucleiStudio - o X
File Edit Source Refactor Navigate Search Project Run RV-Tools Window Help
%/[0][®] 0Run 5 myProj Debug =hs B RSP ON WD A E LG HE YO A ATISE v Sy cflveevey [Quick Access|!| @ | B
& Project Explorer : X 4 main.c © 2 & Outiine 2 a
vs2 ~ rERRY o R
S incid New 3 Project.. - u stdioh
@ main GO Into File = main(void) : int
Open in New Window ﬁﬂiﬂﬂﬁmﬂiﬂ
Show in Local Terminal >
@ Class
Qri+C i Header File
CUlV ¢ Source File
Delete o Source Folder
Ctri+Alt+Shift+ Down = (/(qu]e(l
’ & Convert to a C/C++ Project (Adds C/C++ Nature)
4 pp T Bample
i CulsN
& Import.. Y project. Do ¥ To run it on a
: Export.. i ific startup.
Build Project
Clean Project
Refresh 5
Close Project
Close Unrelated Project 0 RISC-V World! \n"); Y
Build Targets = =
g Console k@Y
Index >
ielloworld]
Build Configurations >
Profiling Tools >
Validate
© RunAs >
% Debug As >
Profile As >
Restore from Local History...
@ SDK Configuration Tools cule6
# Run C/C++ Code Analysis
Team >
Compare With >
Configure >
Source >
Properties Alt+Enter
52 helloworld & ® @
g S
Kl 4-18 ;
€ New Folder O K
Folder

Create a new folder resource.

Enter or select the parent folder:
2 helloworld

e =
» =2 _helloworld

Folder name: application\

Advanced >>

2

Kl 4-19 S5RGBT itk
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4.3.2.Bic BT B I nuclei_sdk

AR nuclei_sdk AR H H, SDK FJEARNEARCAMELNE, 1TUSH
https://doc.nucleisys.com/nuclei sdk/index.html. #1575 E4#H SDK fHAIF 4, 2
Github FRHL 4 #1¥) Nuclei SDK Vif%, ##:401T: https://github.com/Nuclei-Software/nuclei-
sdk. KA nuclei_sdk H helloworld 7FZ I SCAHMARIIH K038, BAGPERINT:

® i}t A\ Nuclei Studio ¥ 2_helloworld Wi H, #HanF 87N nucleisdk J5 044

& W 4-20 fisR, 1E Project Explorer £ 91i%& 9 2_helloworld TiH, i Risf
B, 1&FF “Properties” FTH TR E T

& WK 4-21 Frox, EFEBRE O REE “Resource” , EA MY Location £ H
s A M E Sk BAs =, 2t SCf 5 HE 2 helloworld T H ) ST
JefrH .

& KB 4-7 HA4EI) nuclei-eclipse_demo.rar &4 £ ) nuclei_sdk S04 3 5
7T 2_helloworld i H KT H & T, WE 4-22 Fiis.

€ [1%] Nuclei Studio, 7E Project Explorer £+ 2_helloworld Wi H, i fr
FgE, %P “Refresh” , WIE 4-23 iR

@ Refresh 2 J5 2_helloworld 5i B ) T & 7] LAE 2 nuclei sdk SCAEJE, WK 4-24
i, ZHESER T nuclei sdk VLRI SN

ARSCAE PR A BRI SR B T, REERBHECER S T, AHERE. SR s i A S 2 il oy WA W 39
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@ CPDE - NucleiStudio
File Edit Source Refactor Navigate Search Project Run RV-Tools Window Help

4|0 [=| ORun

& Project Explorer :
~ 1 hello_world
 Binaries
# Includes
& application
& Debug
& nuclel sdk
hello_world_

@ hello_world_debug o (=8 LRSS R al-1aY

e

New >
Go Into

Open in New Window

Show in Local Terminal »
Copy CtriaC
Paste Ctri+V
Delete Delete
Remove from Context Ctrl+Alt+Shift+ Down
Source >
Move

Rename.. 2

s Import...

# O

%0

Export

Build Project

Clean Project

Refresh F5
Close Project

Close Unrelated Project

Build Targets >
Index »
Build Configurations >
Profiling Tools >
Validate

Run As >
Debug As >
Profile As >
Restare from Local History..

SDK Configuration Tools Ctrl+6
Run C/C++ Code Analysis

Team >
Compare With >
Configure >
Source >

e
el

Properties AltsEnter |

WA TE T v ETHETOTR AT &S

* B Qutline

An outline is not available.

4-20 37T TR e B Ik T T T

@ Properties for hello world

C/C++ General
Linux Tools Path
MCU

Project Natures
Project Referenc
Run/Debug Seti
Task Repository
Task Tags
Validation
WikiText

Last modified: 2020628 56H T48:09:33
Text file encoding

(® Inherited from container (GBK)

() Other: GBK

[] Store the encoding of derived resources separately

New text file line delimiter
(®) Inherited from container (Windows)
(O Other: Windows

type filter text Resource ’
{Resource] Path: /hello_world
Builders Type: Proiect
C/C++ Build S e
Location: D:\CPDE\hello world

Restore Defaults Apply

Apply and Close Cancel

4-21 e HE 1 hello_world i H 3Tk A7 B

[Quick Access||| = | B

s} *

~Evs

AR N E RSO G RBHOM KA, REURBHRE I, AR sl e A2 A i sl A
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.settings

application

2020/8/517:46
2020/8/5 17:46

S
S

L

nuclei sdk

2020/8/5 17:46

{3 I

O
O

' | hello world_debug_openocd.launch

@ CPDE - myProj/src/main.c - NucleiStu

.cproject
.project

udio

2020/8/517:46
2020/8/5 17:46
2020/8/5 18:11

4-22 i nuclei_sdk x5

File Edit Source Refactor Navigate Search Project Run RV-Tools Window Help

%][o][=] -
& Project Explorer =
& muProi
New
Golnto
Open in New Window
Show in Local Terminal
w Copy
Paste
% Delete
Remove fram Context
Source
Move._.
Rename...
& Import...
i Export..
Build Project
Clean Project

__Refresh

Ctri+C

CtrlsV

Delete

Crl+Alt+Shift+ Down
»

Close Praject
Close Unrelated Project
Build Targets
Index
Build Canfigurations
Prafiling Tools
Validate
© RunAs
4 Debug As
Prafile As
Restore from Local Histary..
@ SDK Configuration Tools
% Run C/C++ Code Analysis
Team
Compare With
Configure
Source

Properties

= myProj

Ctri+6

Alt+Enter

~ | No Launch Configurations - on: -

»

=R R e - N S-S T R R SR R I AR A =i
& main c
107®
3 Name : main.c
4 Author
5 Version
6 Copyright : Your copyright notice
7 Description : Hello RISC-V World in ¢
8
18
11 #include <stdio.h>
12
13=/

14 = Demonstrate how to print a greeting message on standard output
15 * and exit.

17 * WARNING: This is a build-only project. Do not try to run it on s
18 = physical board, since it lacks tha device specific startup

18 */

20

214

nt
22 main(void)

3 {
4 printf("Hello RISC-V World!™ "\n");
5 return 8;

lems sks @ Console per
GNU MCU Eclipse Packs console

Loading repos summaries...

Parsing cached content file "D:\Packages\.cache\.content_www_keil_com_pack_index_pidx.xml"...
File does not exist, ignored.

Identifying installed packages...

Found no installed packages.

Completed in 3ms.

Mo installed packages.

Completed in 3ms.

Kl 4-23 Jlr LA

CPROJECT 3t
PROJECT 344
LAUNCH 3744

= 0 & Outline = sk

u stdioh
= mainivoid) - int

- =] x

[Quick Access|| == | &
=n

LR I

AR N E RSO G RBHOM KA, REURBHRE I, AR sl e A2 A i sl A
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v == 2 helloworld
m Includes
v (= application
g main.c
v = nuclei_sdk
v = NMSIS
= Core
v = 5S0C
v = hbird
= Board
v = Common
= Include
= Source

[l 4-24 FREEBIH FEF S0
4.3.3. BLE I B K14 PR AN B I
T AL PR RENS 7 B g P, 22 G B G P R A T

TR AT RE NSRRI GCC T HAEMH FIED, S57F Linux M85 A i
(IR A8 I S8 ARSI IR 4

B B 2 F 5 R T ) P IR T
B 7f Project Explorer #:71i% 4 hello_world Wi H , i Arf#, #%4%F “Properties” .

B EEEME AT, BIF C/C++ Build 325, Hifi “Setting” , 7E4 M Tool Settings
HAdt r e

B UK 4-25 ffion, %9 Target Processor, FRATHINZ 2 N3o7, [R5 B 42 08 K sz ik
BCE IR, 29T,

® Architecture: i%# RV32l.,

ARSCAE PR A BRI SR B T, REERBHECER S T, AHERE. SR s i A S 2 il oy WA T 42
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® Multiply extension (RVM) : FH4Jik,

® Atomic extension (RVA) : F4ik.

® Compressed extension (RVC) : 754)ik,

® Integer API: #%# “ILP32” .

® Floting Point ABI:

® Code model: iE#*

o A TNAM “Apply” %4,

1% F% single precision

“Medium Any” .

type filter text

Resource
Builders
wv C/C++ Build
Build Variabl«
Environment
Logging

Tool Chain Ec
C/C++ General
Linux Tools Path
MCU
Project Natures
Project Referenc
Run/Debug Seti
Task Repository
Task Tags
Validation
WikiText

@ Properties for 2_helloworld

Settings

Configuration: Debug [ Active ]

~ | ' Manage Configurations...

% Tool Settings ® Toolchains M Devices O Container Settings # Build Steps Build Artifact & Binary Parsers @ Error Parsers

I@ Target P rocessorIQ

& Optimization
& Warnings
& Debugging
® GNU RISC-V Cross Assembler
2 Preprocessor
% Includes
@ Warnings
3 Miscellaneous
~ ® GNU RISC-V Cross C Compiler
2 Preprocessor
@2 Includes
2 Optimization
@2 Warnings
& Miscellaneous
~ ® GNU RISC-V Cross C++ Compiler
2 Preprocessor
% Includes
(2 Optimization
@ Warnings
& Miscellaneous
GNU RISC-V Cross C++ Linker
2 General
= Libraries
% Miscellaneous
~ ® GNU RISC-V Cross Create Flash Image
& General
~ ® GNU RISC-V Cross Create Listing
% General
GNU RISC-V Cross Print Size
¢ General

<

<
@

<
@

o

IArchitecture RV32I (-march=rv32i*) v
Multiply extension (RVM)
Atomic extension (RVA)

Floating point Single precision extension (RVF) »
Compressed extension (RVC)

Integer ABI ILP32 (-mabi=ilp32*) 4
Floating point ABI |Single precision (f) hd
ITuning Toolchain default ™
Code model Medium Any (-mcmodel=medany) ~

Small data limit |

Align Toolchain default (-mtune) b
(] Small prologue/epilogue (-msave-restore)
Force string operations to call library functions (-mmemcpy)
] Allow use of PLTs (-mplt)
[ ] Floating-point divide/sqrt instructions (-mfdiv)

Other target flags ‘

(4]
Restore Defaults l Apply I

Apply and Close, Cancel

4-25 fii & Target Processor 1E77

B 1 4-26 i, iEH “Optimization” , 4% H8 B R 20 & Bl & E .

ARSCAE PR A BRI SR B T, REERBHCR e P al, APHER. S HI sl A SO 2 2 sih o N .
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® Optimization Level: i%#% Optimization Most (-02).
® fRKiKzik:

€ Function Sections (-ffunction-sections)

€ Data Sections (-fdata-sections)

€ No common unitialized (-fno-common)

. FIRIET NE K GCC iRt ie I, &M BT8R GCC Tt 7 &
s

o A TNAM “Apply” %4,

€ Properties for 2_helloworld O s
type filter text Settings Cvovy
Resource
Builders —
« C/C++ Build Configuration: |Debug [ Active] ~ Manage Configurations...
Build Variabl«

Environment Ny
® Tool Settings ® Toolchains B Devices 0 Container Settings # Build Steps Build Artifact & Binary Parsers @ Error Parsers

Logging
2 Target Processor © | Optimization Level Optimize more (-02) hd
Tool Chain Ec [;:Optimization (2] [] Message length (-fmessage-length=0)
= =
E_/CJrJrTGS‘nT;a‘h Z‘Warmng.s []'char' is signed (-fsigned-char)
inux Tools Patl & Debugging Function sections (-ffunction-sections)
MCU ~ ® GNU RISC-V Cross Assembler . .
. Data sections (-fdata-sections)
Project Natures 2 Preprocessor N itialized (-fi
Project Referenc & Includes 0 common unitialize ¢ not(c?mmon) i
Run/Debug Seti & Warnings [1Do not inline functions (-fno-inline-functions)
Task Repository & Miscellaneous [] Assume freestanding environment (-ffreestanding)
Task Tags ~ ® GNU RISC-V Cross C Compiler [] Disable builtin (-fno-builtin)
Validation & Preprocessor []Single precision constants (-fsingle-precision-constant)
WikiText @& Includes [] Position independent code (-fPIC)
@& Optimization [] Link-time optimizer (-flto)
& Warnings [] Disable loop invariant move (-fno-move-loop-invariants)
& Miscellaneous Other optimization flags ‘
~ ® GNU RISC-V Cross C++ Compiler

@3 Preprocessor
@2 Includes
@2 Optimization
¢ Warnings
2 Miscellaneous
~ ® GNU RISC-V Cross C++ Linker
& General
& Libraries
& Miscellaneous
~ ® GNU RISC-V Cross Create Flash Image
¢ General
~ ® GNU RISC-V Cross Create Listing
& General
~ ® GNU RISC-V Cross Print Size
& General

(4]

@ B Restore Defaults -
@ Apply and Close| Cancel

K 4-26 i & Optimization &
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B E 4-27 fios, 1% Debugging, 1418 B v s /A) ik i B ik 0,

® Debug Level: #£# Default (-g)-

® it MM “Apply” 4.

519009

type filter text
Resource
Builders
+ C/C++ Build
Build Variabl«
Environment
Logging
o
ain Ec
C/C++ General
Linux Tools Path
Mcu
Project Natures
Project Referenc
Run/Debug Setl
Task Repository
Task Tags
Validation
WikiText

@ Properties for myProj

Settings

Configuration: Debug [ Active |

® Tool Settings # Toolchains M Devices O Container Settings # Build Steps

Build Artifact @ Binary Parsers @ Error Parsers

~ | Manage Configurations...

& Target Processor
& Optimization
(2 Warnings
[ochugais] @
~ ® GNU RISC-V Cross Assembler
2 Preprocessor
& Includes
& Warnings
2 Miscellaneous
~ ® GNU RISC-V Cross C Compiler
2 Preprocessor
& Includes
& Optimization
2 Warnings
2 Miscellaneous
~ ® GNU RISC-V Cross C Linker
& General
& Libraries
2 Miscellaneous

¢ General

~ ® GNU RISC-V Cross Create Listing
& General

~ ® GNU RISC-V Cross Print Size
= General

e

~ ® GNU RISC-V Cross Create Flash Image

Debug level Default (-g)

Debug format
[] Generate prof information (-p)
] Generate gprof information (-pg)

Toolchain default ¥

Other debugging flags ‘

[4)
Restore Defaults Apply

Apply and Close|

Cancel

4-27 i & Debugging I

B %" GNU RISC-V Cross C Linker 1] General.

® UK 4-28 o, LML DRI E BERL 1T R BRI A

& kA BRI iR,

& EFHE DT HRD “Workspace” 12441 .

& XHEFAEH HummingBird PFAEH, i BLAT UL ILM T 808 2006 B
gee_hbird_ilm.1d SCfF. ESRH I % #E NucleiStudio SCfH 111

ARSCAE PR A BRI SR B T, REERBHCR e P al, APHER. S HI sl A SO 2 2 sih o N .
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nuclei_sdk/SoC/hbird/Board/hbird_eval/Source/GCC {13 T
gee_hbird_ilm.1d CfF. HAD B DI LA SO, &SN AT, 1
A B QS Pri ik #E

® gcc_hbird_ilm.1d JAKFE 7 ACIY BRI WA ILM (b hEIX (8], BRE R K
W E R N EE MCU (19 ILM 77, Jf A ILM FF46347. ILM f SRAM 4H %,
SpaE R

® gcc_hbird_flash.ld FIAFE P B EE bk 24 3R Flash [X 8], EEARAD BEHY
WL AR ILM bk X 8], SRR R4 B T 3 MCU 1Y
Flash v, {H:2 b r )5 EZi81d 5] SRS Bz 2 ILM 285 A ILM
O IR IRAT

® gcc hbird flashxip.ld BIASHEFACHS BL 20K Flash [X[H], SURER TR H
P R #AE MCU ff) Flash 4, 3 B4 M Flash 4T . FEF#EES 7E Flash
H, Ao ER.

o HPmUZIEH T RIEBFA G EIIA ., R REIERE
gee_hbird_ilm.1d 1F MR,

& EEHERDA NN “Apply” %4

ARSCAE PR A B FIRABUN SR B T, RGBS B, AHERE . S sl e A S 2 e WA Wi 46
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N 4-29 o, ZEIR ) S B I,

@ Properties for 2_helloworld

type filter text Settings
Resource
Builders

v C/C++ Build

Build Variabl«

Environment

Loggi

Configuration: Debug [Active ]

® Tool Settings ® Toolchains M Devices 0 Container Settings . Build Steps

~ | Manage Configurations...

Build Artifact [ Binary Parsers @ Error Parsers

(1] & Target Processor Script files (-T) [3]

Tool Chain Ec & Optimization ‘
C/C++ General & Warnings @ File selection O X
Linux Tools Path & Debugging |
Mcu v B Add file path Select one or more Workspace Files
Project Natures
Project Referenc File: v & 2_helloworld A
Run/Debug Seti ‘ & settings
Task Repository = application
Task Tags v g v & nuclei_sdk
Validation & NMSIS
WikiText v = SoC

0 o ~ & hbird
Cancel File syster + = Board
EFIVIISCernaneous 1 v = hbird_eval
v ® GNU RISC-V Cross C Linker & Include
o v & Source
@ Libraries ~ = GCC
& Miscellaneous 5 gee_hbird_ddr.ld
~ & GNU RISC-V Cross Create Flash Image
= General
~ ® GNU RISC-V Cross Create Listing
% General 5 openocd_hbird.cfg v
v (ir‘“g RISC"V Cross Print Size [] Do not use standard start files |
£ benera [1Do not use default libraries (-n( 9
[INo startup or default libs (-nos @ I OK I ‘ e ‘
Remove unused sections (-Xlin|
rint removed sections (-Xlinker --print-gc-sections;
[Jpri d sections (-Xlink i ions)
] Omit all symbol information (-s) 0
< > Restore Defaults Apply
@ Apply and Close| Cancel

i 4

Do not use standard start files (

28 e B 4 I A
AR

-nostartfiles) -

Remove unused sections (--gc-sections).

B T AR “Apply” %74

DRI
=

R il A B GCC Bk, I BAT & B GCC T 1 & 3.

AN PITIR A BB ER BT, RSP R TIRA, AMSAERR . S Sl e A SO 2 A iR sl A
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type filter text
Resource
Builders
v C/C++ Build
Build Variable
Environment
Logging
Settings
Tool Chain Ec
C/C++ General
Linux Tools Path
MCu
Project Natures
Project Referenc
Run/Debug Setl
Task Repository
Task Tags
Validation
WikiText

®

@ Properties for myProj

Settings

Configuration: Debug [Active ]

% Tool Settings ® Toolchains B Devices O Container Settings # Build Steps

~ |Manage Configurations...

Build Artifact & Binary Parsers @ Error Parsers

<

~

<

& Target Processor
(& Optimization
& Warnings
& Debugging
® GNU RISC-V Cross Assembler
( Preprocessor
& Includes
¢ Warnings
# Miscellaneous
& GNU RISC-V Cross C Compiler
( Preprocessor
& Includes
& Optimization
& Warnings
& Miscellaneous
& GNU RISC-V Cross C Linker
# General
& Libraries
2 Miscellaneous
& GNU RISC-V Cross Create Flash Image

Script files (-T) 28 8

"${workspace loc:/${ProjName}/nuclei sdk/SoC/hbird/Board/hbird eval/Source/(

% General
~ & GNU RISC-V Cross Create Listing < >
5
© ENGUEETSVS‘ Ve Print Si | Do not use standard start files (fnostartﬂ\es)l
v _
& General ross Frint Size Do not use default libraries (-nodefaultlibs)
[INo startup or default libs (-nostdlib)
|| Remove unused sections (-Xlinker ffgcfsedh)ns)l
L[ Print removed sections (-Xlinker --print-gc-sections)
] Omit all symbol information (-s)
Restore Defaults Apply

Apply and Close

Cancel

B & 4-30 s, %9 GNU RISC-V Cross C Linker # Miscellaneous, %1#

P B T

A Hello World £ ) Printf 475 Z 3T B S 5L,

4-29 fid B 558 General i£T0

&

r)i% “Use newlib-nano” .

Fr AANEL 2% “Use

nano printf” .

o AL NMAM “Apply” %4

AR N E RSO G RBHOM KA, REURBHRE I, AR sl e A2 A i sl A

B pIrR 23k
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@ Properties for myProj m| X
type filter text Settings LA
Resource
Builders
« C/C++ Build Configuration: Debug [Active ] ~ | Manage Configurations...
Build Variable
Environment - - . . . . . 7 5 g
Logging % Tool Settings ® Toolchains B Devices 0 Container Settings # Build Steps Build Artifact & Binary Parsers @ Error Parsers
Settings = Target Processor Linker flags (-Xlinker [option]) £
Tool Chain Ec 2 Optimization
C/C++ General ¢ Warnings
Linux Tools Path ¢ Debugging
MCU v ® GNU RISC-V Cross Assembler
Project Natures 2 Preprocessor
Project Referenc 2 Includes
Run/Debug Sett @& Warnings
Task Repository (2 Miscellaneous
Tas_k Tags v ® GNU RISC-V Cross C Compiler Other objects )
Validation (2 Preprocessor
WikiText @ Includes
(2 Optimization
& Warnings
& Miscellaneous
v & GNU RISC-V Cross C Linker
(2 General
Libraries
v ® GNU RISC-V Cross Create Flash Image | Generate map ‘”!B{BuiIdArt\'fa(tFi\eBaseName}.map”
& General [ Cross reference (-Xlinker --cref)
v ® GNU RISC-V Cross Create Listing [ Print link map (-Xlinker --print-map)
& General [v] Use newlib-nano (Wspetsznano.specs)l
v ® GNURISC-V Cross Print Size L] Use float with nano printf (-u _printf float)
& General [JUse float with nano scanf (-u _scanf_float)
[[] Do not use syscalls (--specs=nosys.specs)
[]Verbose (-v)
Other linker flags ‘
= = Restore Defaults Apply
® [RopiyandGise] | Conce

4-30 fi B &R Miscellaneous %17

4.3.4. BB B KA & BRI S
N T RERS IR Y1 nucleisdk ST R SCAE, TR EGZ IR A0 P IR B O H WA B AR A
(L
B K 4-20 AT7~, 7E Project Explorer #2A41i% 7 hello_world Wi H, i MbrA#E, E#F
“Properties”
B EEEME AT, BIF C/C++ Build 325, Hifi “Setting” , 7E4 M Tool Settings
H e T i &
B {0E 4-31 fizR, %5 GNU RISC-V Cross C Assembler [ Includes, %[ B plr s id &
BEAE, BRI

ARSCAE PR A BRI SR B T, REERBHCR e P al, APHER. S HI sl A SO 2 2 sih o N . TR 49
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® ¥ Include paths % H .3 N5 4
® B AIE st “Workspace” , i Folder selection % .
® {f Folder selection % 173 #:35 H 1Y nuclei_sdk H % K] NMSIS>Core>Include
A

® T{EATMEATd “Apply” 5EHACE -

B R R, KIKESIN nuclei_sdk H 3% T
SoC>hbird>Board>hbird_eval>Include, SoC>hbird>Common>Include Fl
SoC>hbird>Common>Source>Stubs A N EIA, FERAFFER AN GNU

RISC-V Cross C Compiler ] Includes 1= H X B & #g15. WE TG HUE 4-32
FrR.

(5]
type filter text Settings . o
Resource
Builders
« C/C++ Build Configuration: Debug [ Active ] ~  Manage Configurations...
Build Variable
E:;"";’:'“‘“”l ® Tool Settings = Toolchains M Devices @ Container Settings # Build Steps ® Build Artifact & Binary Parsers @ Error Parsers
gging
Settings| @  Target Processor Include paths (-1} o[}
Tool Chain Ec & Optimization
C/C++ General ® Warnings
Linux Tools Path & Debugging @
MCu

Project Natures
Project Referenc
Run/Debug Set!

Select one or more Workspace Folders

v &2 helloworld

settings
Task Repository @ Miscellaneous ;e HE;GH
Task Tags « ® GNU RISC-V Cross C Compiler M
Validation (= Preprocessor Include system paths (-isystem) | o & NMSIS (4
WikiText  Includes .
v & Core
@ (5]
> SoC
Directory:
o o ' '
Cancel File system... =~ | 1
T = oenerar T
~ ® GNU RISC-V Cross Print Size
@ General
Q
2 [ ok | Cancel
0
2 > Restare Defaults Apply
7 Apply and Close Cancel

4-31 % H GNU RISC-V Cross C Assembler i Includes ¥ H & %1%

ARSCAE PR A BRI SR B T, REERBHCR e P al, APHER. S HI sl A SO 2 2 sih o N . Wi 50
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type filter text
Resource
Builders
v C/C++ Build
Build Variabl
Environment
Logging
Settings
Tool Chain Ec
C/C++ General
Linux Tools Path
MCuU
Project Natures
Project Referenc
Run/Debug Seti
Task Repository
Task Tags
Validation
WikiText

@ Properties for myProj

Settings

Configuration: |Debug [ Active ]

® Tool Settings & Toolchains B Devices 0 Container Settings # Build Steps

~ 'Manage Configurations...

Build Artifact [ Binary Parsers @ Error Parsers

¢ Target Processor
@ Optimization
& Warnings
& Debugging
v ® GNU RISC-V Cross Assembler
(2 Preprocessor
& Warnings
& Miscellaneous
~ & GNU RISC-V Cross C Compiler
(2 Preprocessor
& Optimization
¢ Warnings
¢ Miscellaneous
v ® GNU RISC-V Cross C Linker
¢ General
¢ Libraries
& Miscellaneous
~ ® GNU RISC-V Cross Create Flash Image
& General
~ ® GNU RISC-V Cross Create Listing
¢ General
v ® GNU RISC-V Cross Print Size
¢ General

Include paths (-1) 2884 H
"${workspace loc/${ProjName}/nuclei sdk/NMSIS/Core/Include}”
”B(workspa(ejo(:/$(ProjName)/nudeiisdk/SnC/hb\'rd/Board/hb\'rdieva\/\ndude)
"$(workspa(ejo(:/$(ProjName}/nudeLsdk/SnC/hb\'rd/Commcn/\ndude}”
"${workspace_loc:/${ProjName}/nuclei_sdk/SoC/hbird/Common/Source/Stubs}”

< >

Include system paths (-isystem) =]

Include files (-include) L3

Restore Defaults Apply

Apply and Close Cancel

K 4-32 % & GNU RISC-V Cross C Compiler 7 Includes # H 8 & %42

4.4. ETOHK Makefile BT H

AT A A {8 ] E. 4 ) Makefile £ Nuclei Studio IDE 1] —Mifi fif Makefile ] Hello
World B H . &4~ HummingBird Evaluation Board, H#% A N307. 1#55% F# Nuclei
SDK, Github ##:4: https://github.com/Nuclei-Software/nuclei-sdk. 1% /7i%k T RIZETH 2
bb, B T/ETHRE S MLTUNEEIE, X H U helloworld A, TEAPERITT .

4.4.1. FhFEHHE

Ak “File—> New —> Makefile Project with Existing Code” . [ 4-33 Jit

N

WE 4-34 B, EEbs 1 A TR, X BFATr % N nuclei-sdk. 7EFE#r 2 4% A SDK
(IS iRig 2. fEEFR 3 4bikE “RISC-V Cross GCC” . HidiEbr 4 52U &g .

ARSCAE PR A BRI SR B T, REERBHCR e P al, APHER. S HI sl A SO 2 2 sih o N .

T 51


https://github.com/Nuclei-Software/nuclei-sdk

R
NUCLEI

@ CPDE - NucleiStudio

fFilcJedit_Source Refoctor Mavigate Search Project Run RV-Tools Window Help

Alt+Shift+N >f~  Makefile Project with Exis

Open Flle.
2 Open Projects from File System...
Recent Files

Close

& Ref
Convert line Delimiters To
Print.
Import
& Bxport.

Properties

Switch Workspace
Restart
Exit

GripvOThrArinG g i -

TC/Co+ Projec
1 Project...

» E Comvertto a C/C++ Autotools Project

© Comverttoa C/C++ Project (Adds C/C+ + Nature)

CUEWE g source Folder

CUlSHIeW o3 Folder
Cirlss € Source File
W Header File
Cirlsshiftes 0 File from Template
& Class
= Task
[y T Example.
F5 I Other CirleN
>
Ctrle P
Alt+Enter

3

! DConsole T Propert
Mo consoles 1o display at this time.

4-33 Frid kT Makefile 1 L&

- =] *

Quick Access| | = | &
© & Outline ps

An outline is not available.

@ New Project

Import Existing Code

Create a new Makefile project from existing code in that same directory

Project Name Q

Inucleifsdk I

Existing Code Location (2]

I CAUsers\24954\Desktop\nuclei-sdk

‘ Browse...l

Languages
C[v]C++

Toolchain for Indexer Settings

<none>
Cross GCC
Autotools Toglchain 6

NU A
RISC-V Cross GCC

Show only available toolchains that support this platform

Y

W’

°

Cancel

K 4-34 B TREED

AR N E RSO G RBHOM KA, REURBHRE I, AR sl e A2 A i sl A
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4.4.2. %8 Makefile B42H1 Build &

A Er @ e ) TR, EF “Properties” FTHWE I, WK 4-35, 1E#H “C/C++ Build” ,
7t “Build Location” #Hi&# “Workspace” . 7E5H FIFE ik “application —> baremetal
—> helloworld” s “OK” H b “Apply” £RA7.

type flter text e T " Select a folder from workspace:
Resource
Builders ~ & nuclei-sdk A
C/C++ Build] @ Configuration: Default [Active ] | Manage Configurations... & .
C/C++ General & .setti.ngs.
Li Tools Path . . ~ = application
inux Tools Pa El Builder Settings @ Behavior « Refresh Policy « & baremetal

MCU

Project Natures Builder :b benchmark
Project Referenc Builder type: External builder = demo_dsr_;
Run/Debug Setl Use default build command & demo_eclic
i = demo timer
Task Repository . . -
Task Tags Build command: ${(rossimake} Variables... vl hellow_'orld 9
Validation Makefile generation @ main.c
WikiText . . ; ] & Makefile
[] Generate Makefiles automatically Expand Env. Variable Refs in Makefiles i
= freertos
Build location & rtthread
Build directory: |$|w0rk5pa(ejo(:]nudeifsdk/app\\'(at\'on/baremeta\/he\\Dwor\d} ‘ & ucosii

= board-labs

File system...| Variables... = Build
2] = doc
= NMSIS .

6 ——

< > Restore Defaults I Apply I o
@ Apply and Close Cancel @ Cancel

4-35 & Makefile %1%

UK 4-36, 7£ “C/C++ Build” #i%&#% “Behavior” £ H, #iffa)i% “Build (Incremental
Build) ” #&IiJH4 A “all CORE=n307 DOWNLOAD=ilm” . " “CORE” & IUARH 5 b 1 Py
%A, X HLLL n3oy A, “DOWNLOAD” MEI A LMESIA I FEME, HAIES% 4.1
i, XHEPLilm A . K oHIFEE ) HummingBird Evaluation Board, FiPA SoC i1 Board
HA LB, oAl AT & H, L RVSTAR M|, iEfEILAL BN “SOC=gd32vf103
BOARD=gd32vfi03v_rvstar” , F%H T RVSTAR ¥ % # FLASHXIP #iz{, 206

“DOWNLOAD” % &N “flashxip” , [F “CORE” 12N “n205” . 5EHG fiti “Apply”
RAF B

ARSCAE PR A BRI SR B T, REERBHECER S T, AHERE. SR s i A S 2 il oy WA T 53
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&) Properties for nuclei-sdk | X
type filter text C/C++ Build e

Resource

Builders

C/C++ Build] @ Configuration: Default [ Active] ~ | Manage Configurations...

C/C++ General (2]

Linux Tools Path = n

I\‘/Ir:iuL)J( oolsta EEl Builder Setting““ Refresh Policy

Project Natures Build settings

Project Referenc Stop on first build error []Enable parallel build

Run/Debug Set Use optimal jobs (8)

Task Repository Use parallel jobs: 8 =

Task Tags Use unlimited jobs

Va-\ifjation Workbench Build Behavior

WikiText Workbench build type: Make build target:
[1Build on resource save (Auto build) all Variables...
Note: See Worki)ench automatic build preference

OI Build (Incremental build) ‘a\l CORE=n307 DOWNLOAD=ilm ‘ Variables... I
Clean ‘(Iean ‘ Variables...
(4]
< > Restore Defaults I Apply I
@ Apply and Close Cancel

4-36 P& Build 17

e LR RS, STOT T AR E T, WK 4-36, ZEIPECE, st “Apply” fRIF1E

e

AR N E RSO G RBHOM KA, REURBHRE I, AR sl e A2 A i sl A

T 54



R
NUCLEI

& Properties for nuclei-sdk-master

| Settings
Resource
Builders :
C/C++ Build Configuration: |Default [ Active ] ~ | Manage Configurations...
Build Variables
Environment :
_____ & Toolchains Binary Parsers € Error Parsers
Setti ; ; ; 1
) Name: RISC-V Nuclei GCC (riscv-nuclei-elf-gee) |
Tool Chain Editor
C/C++ General Architecture: | RISC-V v‘
Linux Tools Path
i feeis e Prefix [risev-nuclei-elf- |
MCU
Project Natures Suffix: [ |
Project References Coompiler:  [gee ‘

Run/Debug Settings
Task Repository
Task Tags
Validation |
WikiText |Tu0\:hain path: [${eclipse_homej\toclchain\geeibin |

fio shang it uss the alobal or workspace preferences pages or the argicit proper

C++ compiler: |g++ ‘
Warning: these definitions da not affect the build and are for the benefit of the inde

IBuiId tocls path: [${eclipse_homel\taclchain\build-tacls\bin |

to change it use the global or workspace preferences pages or the project proper

Restore Defaults Apply
@ Apply and Close | Cancel

4-37 WCE T HBERT

RPEIEAT UL R N A S B % 5. 6 1.

5. 9w H
5.1. Nuclei SDK THE#ETA

£ Nuclei Studio # 7] LLifiid Nuclei SDK T2 & T H—# & %@ T Nuclei SDK Project
Wizard &M TREM 9 B REHOE T . R T ARSI F 3R B MET Makefile )2
I . TP IR T

B FEEMN TR, 2 5E 5-1 #77JF RV-Tools>SDK Configuration Tools, 7] LA#T
HAE M g I T3 . ] LRGBS TR S, W s-2, S TR TERE THAE

AR N E RSO G RBHOM KA, REURBHRE I, AR sl e A2 A i sl A T 55
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bro HRE A EBMN TGS, BT crlv6. WU HEES K TG, e 5-3, A
FIFF AR, %% SDK Configuration Tools. W& 5-4 A TFERE T H#ME, KiETIEMIIGE
R

B projectName A FIEF I T4

B Configuration Core i LIEX NN . BT THMRIE ARCH Al ABI 6 10 52 #E Hi %
PR, TS R G A% AT R A E) ) ARCH AU ABL 335, BT LR B AT RS2 i
7%, WE ARCH 5 ABI NIERAMIETRI AT . (e 500k 77 (0 PR 1) 46 A A% 38 0456 FH

B ARCH Xf ¥ 24 TAEH arch £,
B ABI XM 2T TAER abi #670.

B Download Xf N 477 TFER N A, AT PAYIHk AR R P, H iU S I Rk
YR R R, RVSTAR X4 FLASHXIP #i:K,

B NewLIB %N [¥{ H] NEWLIB FE. 7] LLk4% 2 5 H nano FE, 72 & R4 EL.
B Optimization Level X} 5 g% 4L 221 .

B Extra Common Flags X B (1) /& 4 M 130 FH gm it I, vl LA DA A 1 38 FH g 36 46 701
B Extra C Flags X N HJ/2 &AM C g il il w] LATSINARAM C g 1L T

B Extra C++ Flags X N 22N C++9mifii . 7] A INALSME C++5 1L 10

B Extra ASM Flags i B )2 BUA RV g 2 Bafe T . 7T LIS IN A4/ ) 91 20 0 B 226 100

W Extra Link Flags Xf M A2 BN SERE I, an R IR I S BRI IE T H 7 2258 N gw
PEIETI, T DAAE G B I Sk B R AR — > 2SR 55 A 0 4 PR T

a7 Z B LL BT, X B RAME SIS S N-0s LA AT AT SO R/ e il
save — BN LI, AWK 5-5, AdrBENUE I TREITTA#SH, %FF “Clean
Project” JHE— N LA, i3 EbR R AT 58 A2 oo 196 4 00 T 4 1 R

AN PITIR A BB SR T BT, RSP RS, AR R sl e A SO 2 Al el 2y A W 56
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@ CPDE - NucleiStudio

= (=]
File Edit Source Refactor Navigate Search Project Runf RV-Tools |Window Help
%|[0][®]/0Run = hello_world_debug ¢ @ SDK Configuration Tools Ctrl+6

PEyoyinvOvhvQAvidssy vhvreovaw Quick Access| |
Nuclel System Technology Homepage
& Project Explorer i i = £ Outline i Build . %
Nuclei SDK Documentation
~ 5 hello_world :
& Includes NMSIS Documentation An outline is not available.
= application
= nuclei_sdk

hello_world_debug_openocd launch

£ Problems < Tasks © Console  ©lProperties & Terminal “ b IR = Tl
GNU MCU Eclipse Packs console

Completed in 3ms.

No installed packages.

Completed in 3ms.

2020-08-06 11:13:08
Extracting devices & boards...
No installed packages.|
Completed in 2ms.

Bl 5-1 4TIHE S PRI & 1

@ CPDE - NucleiStudio

- o x

File Edit Source Refactor Navigate Search Project Run RV-Tools Window Help
&][0][m] 0Run « @1 _helloworld_debug_~ | % v svqa-ae-onss@a-ererersro-a-arize s THrEerD [cruick Access|| = | &
& Project Explorer © asle -=a = EOutline Build Tar... % Docur
~ & 1_helloworld v

& Binaries An outline is not avallable.

 Includes

& application

& Debug

& nuclei sdk

1_helloworld_debug_openocd launch

Probler Tacks @ Console » nal [ HEE -
CDT Build Console [1_helloworld]

1 helloworld

Bl 5-2 $TIHE S BRI I o 2
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@ CPDE - NucleiStudio

File Edit Source Refactor Navigate Search Project Run

4|0 [=| ORun

& Project Explorer =
~ &1 helloworld
 Binaries
# Includes
& application
& Debug
& nuclel sdk

1_helloworld _deb: &

1 helloworld

11_helloworld_debug_~
B G =

New
Go Into

Open in New Window
Show in Local Terminal
Copy

Paste

Delete

Remave from Context

Source

Move

Rename.
= Import.
“ Export.
Build Project
Clean Project
Refresh
Clase Project
Close Unrelated Project
Build Targets
Index
Build Configurations

Profiling Tools
Validate

© RunAs

# Debug As
Profile As
Restore from Local History...

Ctrl+Alt+Shift+Down

RV-Tools Window Help

LRSS R al-1aY L MR R

5

Ctrl+C
Ctrl+V

Delete

3

@ SDK Configuration Toolks

Ctri+6

T Ton /0 + Code Analyer
Team
Compare With
Configure
Source

Properties

Alt+Enter

@ T HETOTR AN 4

B 5-3 FTIHE e PR I & 3

@ Nuclei SDK Project Configuration

projectName

Configuration :

Core:

ARCH

ABI

Download :

NewlLIB :
Optimization Level :
Extra Common Flags :
Extra C Flags :

Extra C++ Flags :
Extra ASM Flags :
Extra Link Flags :

Save

: 1 _helloworld

Debug v
N600F v

: ‘r\.'32Tmafc |
ilp32f |
ILM >

None(-00)

newlib-nano without print float ~

o

SDK Configuration Tools:1.0.0.0

Cancel

www.nucleisys.com

5-4 —S{E g LI

- o b3
[Quick Access||| = | &
? B Qutline ask List ® Build Tar.. i
An outline is not available.
MDY
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@ CPDE - NucleiStudio - [« ®
File Edit Sou Refactor Navigate Search Project Run RV-Tools Window Help

u - 11 _helloworld_debug (=B s Br AT E W R ST T T E O TR ATISS S TH ey Dy [Quick Access| | = | &8
Prﬁct Explorer ¢ ] £ Qutline

v Sk orld

New ’ An outline is not available.
Go Into

Open in New Window

Audlel_sdk Show in Local Terminal

1_helloworld de
- N Ctrl+C

trl+V
Delete
hift+ Dowr

Build Configurations

Profiling Tools
Validate
© RunAs
t Debug As
Profile As
Restore from Local History..
@ SDK Configuration Tools ctil+6
% Run C/C++ Code Analysis
Team
Compare With

Configure
Source

Properties Alt+Enter

1 helloworld

5-5 i H TREIF HH g 1 A%

TEER PR EY e TR 32 61488 64 7, FFEAT R E I, WK 6-6, B
“command” H “set arch riscv:rv32” N “set arch riscv:rvo4” , M 64 H7 ) H[E 32 A7 N Y
X B S BN R EUE -

5.2. #E Nuclei Studio 4% Hello World i H
7E Nuclei Studio F 4w 1FHIPBU T .

BN RN, B EIEEE— . WK 5-6 fas, & Project Explorer £ H1ik A
hello_world Wi H, B brAH, 13 “Clean Project” .

B R 5-7 fow, B BREETIRA, R ST . R gAYy, RN
e 5-7 Fros, BERSFE B4 BT HAT ST AR AR R RS, B335 text BX. data BOAI bss
Bt PLRCEIR/NE AN R EUE . (8 Makefile 77 20 i i T A% 75 B AE A B
rpik$ “Build Project” #H{T41%.

ARSCAE PR A BRI SR B T, REERBHECER S T, AHERE. SR s i A S 2 il oy WA Wi 59
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@ CPDE - NucleiStudio - [« ®
File Edit Source Refactor Navigate Search Project Run RV-Tools Window Help
A//0/[m] ORun ~ @ hello_world_debug o~ (=8 LRSS R al-1aY WP ETETLTEITIHETOTO YA Sy rhHvGGra - [Quick Access| ;| & | &

& Project Explorer = Bl =
© 5 helln werid
o1 New > An outline is not available.
=i Golnto
&1

& Outline = ok 2

©Open in New Window
Show in Local Terminal >
Copy
Paste

x Delete
Remove from Context
Source >
M
Rename... F2

Import.
4 Export.

Build Project

l Clean Pro)
Refresh S
Close Project

Close Unrelated Project

Build Targets >
Index >
Build Configurations >
Profiling Tools >
Validate
© RunAs >
% Debug As >
Profile As >
Restore from Local History...
© SDK Configuration Tools cul+6
% Run C/C++ Code Analysis
Team > lems & Tasks @ Console rties & a LIRS
Compare With > | GNUMCU Eclipse Packs console
o .| completed in 3ms. ~
Sl [0 Mo installed packages.
Source > |  completed in 3ms.

Properties Alt+Enter 2020-08-06 11:13:08
Extracting devices & boards...
Ho installed packages.
Completed in 2ms.

5 hello world =

5-6 Xt hello_world It H #.ii 45 ik £ “Clean Project”

- MucleiStudio -
CPDE it s} *
le

dit Source Refactor Navigate Search Project Run RV-Tools Window Help

O |®m| ORun ~ @ hello_world_debug o~ (=8 LRSS R al-1aY WP ETETLTEITHETOTOA YA Sy rhHryGGra - |Quick Access| ;| & | &

& Project Explorer
~ & hello_world
 Binaries An outline is not avallable.
# Includes
& application
& Debug
& nuclel sdk
hello_world_debug_openocel launch

Outline = K k.

lems sks @ Console T
CDT Build Console [hello world]
AOVOKINE: LU KISL-T L

2
[riscv-nuclei-elf-size --format=berkeley "hello_world.elf"
o text data bss dec hex filename

7732 112 229¢ 10134 2796 hello_world.elf
[Finished building: hello_world.siz

11:40:18 Build Finished. @ errors, @ warnings. (took 3s.655ms)

5 hello world =

K 5-7 BT Kbas hello_world 1 H #4747 3%
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PR JE AT LB RIIG N T Debug SOk, Wi 5-8, &CAHERWIT:

B hello_world.elf &4 i) m $44T 3

B  hello_world.hex /24 i) Hex Cff.

B hello_world.Ist 2 2E B list SO, WA 3 S 4 AT 50 ARS8 45 R
B hello_world.map »&4E B map X4, AT ULEAE R 2 A2 e ARRS 70 A1 15 0L -

4//0 =] ORun @ hello_world_debug o O Bviva®v O VP @S HTOYU-YQAriS A * bt vy - Quick Access

hello_world Ist hello_world.map Outline
223 .weak eclic_irq5@_handler

/* @: Reserved, Jump to _start when reset for ILM/FlashXIP mode.*/
: 1980006F j 80000198 <_start>
H CEE unimp
If - [none/le] i 9099 Yolsp
H 8532 s1li 9,20,0;
a: 8000 ex8600
0000 unimp
: 6000 unimp
80000010: 8532 s1li 9,20,0:
80000012: 8000 ox8000
AT 80000020: 532 s1li  20,20,8;
= 240 80000022: 8000 ox8000
hello_world_debug_openocd launch 241 80000024 008 undinp
80000026: 0000 unimp
80000028: 0532 s1li 9,30, 0:
8e80002a: 3000 exseee
8000002¢ : 2000 unimp
8000002e: 000 unimp
© Console i)

CDT Build Console [hello_world]

5| Writable Insert 11

5-8 EA A A ST

6. WiAEiTIH
6.1. fEHES AR S OpenOCD HiRia17H H
6.1.1. 3% K28 1K)

Nuclei Studio F| 2021.02 iR 42 openocd =¥ windows AKX ThAE, i FH A & DL |
windows P51 A A AT Bk T, Linux RS RRACEIKS) . (KT HhRA B H P 75 42 B CL R 7

ARSCAE PR A BRI SR B T, REERBHCR e P al, APHER. S HI sl A SO 2 2 sih o N . i 61
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ZAEIRF) .
6.1.1.17F Windows R % 22350535,

PEFPgm eI fE, (] LR AR T 88 FPGA JR BT RGE1T . Bk R BT &S 41 PC
BATER, DPRIT.

O AR I —u A AN ENL PC 1 USB #:1, 7 — i SR BT R BOES: . ERE: Wk
JE A G SRS, N T E/5 L PC ) Windows £ 48 REfE 1 )i 19 iR 2
USB, 5222 3¢0Ka), Xt 1-2 frash) NucleiStudio_IDE 36 ) HBird-
Driver.exe B/ A] 56 St AKX 5 ) 22 3%

B TESIEKEE S T ORI AR G 1) UART # 4 USB” 12hfie, [AitinR
e B IR AR B AL PCARAIRT) (HIRBh 23 %), AR R4 LN — 4
COM H .

® N 6-1F~, fEEMNL PC WA EHRFHA“E: 1 (COM Fl LPT) £ H”Ha] PA#
HF)% COM [FH 15 (B4 COM11) »

® b IS SRR P is AT IR ol 7 24 R AU RIS AT RE 7 9 printf f 2 os % .

ARSCAE PR A BRI SR B T, REERBHECER S T, AHERE. SR s i A S 2 il oy WA T 62
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A REgES - a X
XHHF)  MEA) BBV BENH)
&= = F B

v % DESKTOP-V8C6817 ~
“= IDEATA/ATAPI 2451128
By 2igE
O abimse
- BLERIRENEE
G TriERREISE
= $TEDBAZ
P mBith

v {0 (COM ] LPT
|ﬁ USB Serial Port (COM11)I
¥ EF
0 it
[ e
=R 5
0 &7
) AEEBANRE
B wiFigs
B rpay
i BE. TURIEEEIEE
0 BiFnEftsHHES
§ EBAsTREEE
§ EERTRGRE
P WBERS
in ZRi®
0§ EriEks
il Zsimeh A Enteis ¥

6-1 FER A E M &P & COM $ 15

. RN e iEnEs” MR, HBEESE SIS % Windows IEFHIRA, AR
6 bR AE R D9 215 A BT i IE A 22 2% T HBird-Driver.exe HIKZ), H BB057E & 25 55 BEAR 1 201 2]
COM HJ&# 5.

6.1.1.27F Linux R4 2Lz
7F Linux 855 R 23RS 0 HAT

B 1 EBIJFRRE Linux F1, #f% USB # Linux Pl k. WA BN, WK 6-2,
BRI AAOER] T BRI

W o (EFEH ST sush HESEEE L, SHITEIEELR:

Bus 001 Device 010: ID 0403:6010 Future Technology Devices International, Ltd

FT2232xxxx
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B 3: S P %N sudo vi /etc/udev/rules.d/99-openocd.rules 1§47 99-
openocd.rules 3/, HIAIITNE, RIFIRH

SUBSYSTEM=="usb", ATTR{idVendor}=="0403",

ATTR{idProduct}=="6010", MODE="664", GROUP="plugdev"

SUBSYSTEM=="tty", ATTRS{idVendor}=="0403",

ATTRS{idProduct}=="6010", MODE="664", GROUP="plugdev"
B4 WIS EHEE R Linux R4H

B 5. {fi]1s /dev/ttyUSB*ir & &% ttyUSB (5., ZEHin . /dev/ttyUSBo
/dev/ttyUSB1

B 6: fiiH Is-1/dev/ttyUSB1 s 2 EH S HEE, SEHKH U T : crw-rw-r-- 1 root plugdev
188, 1 Nov 28 12:53 /dev/ttyUSB1

A LLE 2] ttyUSB1 &N plugdev 4, #2 T RILATENG B i) plugdev 4 (AR
WA RES TR, TE R SLBR B EN) o i whoami iy & F 4ATH P 4, A

B HAds% N < your_user_name >.

B 7: {#if] sudo usermod -a -G plugdev <your_user_name>#y2¥ H S0t plugdev
éﬂo

B 8: FRMIAMETH 4 28T plugdev 4, ] groups 4, T LAEFTEHE BFE
plugdev B sl Tk 2410 FH 2 I A plugdev 4. Wi EA AT AR E JH

AN PITIR A BRSO SR BT, RGBSR Ak, B sl A S 2 At el il 2 2% W 64
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ISR = NN

K 6-2 JFRBGERZ EREMALF

6.1.2. HrEt i & Debug Configuration
if#id Nuclei Studio #7# 3 & Debug Configuration 715 BN .
B WIE 6-3 Fun, fERHAEHIERE “Run—>Debug Configurations” .

B K 6-4 P, fEFHE O, WA S TERRRENS, A3%d “GDB
OpenOCD Debugging” , &% “New” , ¥ AT H #ra it — M H
“hello_world_demo Debug” , K 6-5 ffian. Hifk “Project” & mil 75 T
e, “C/C++ Application” Hide#t 1 LA 1) 75 21X ELF 304

B WK 6-6 Fias, EFIHIRIE “hello_world_demo Debug” i Debugger ¥, 7E
Config options #= H HIE A -f
"nuclei_sdk/SoC/hbird/Board/hbird_eval/openocd_hbird.cfg", VA#fifr OpenOCD fi
FH IERA B E S X B B A
(nuclei_sdk/SoC/hbird/Board/hbird_eval/openocd_hbird.cfg) R4 5 br T8
openocd AL B AN E . Flan: 1R H makefile 770 E A THE, BEUtbabii i
2 N-f “SoC/hbird/Board/hbird_eval/openocd_hbird.cfg”.

R4 RT N R A RISC-V 32 A7 W%, 15 #i{% Commands N &7 set arch riscv:rv32

WA MAT ALY 64 £, NATRE #9 set arch riscv:rv64
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B K 6-7 fion, EFHIAIH “hello_world_demo Debug” (] Startup £ 5., Hifx
“Debug in RAM” , “Pre-run/Restart reset” , “Set Breakpoint at Main” #
“Continue” #4)i%.

B i e-7, FERUEATEA T “Apply” PRAFIRE .

@ CPDE - NucleiStudio

- o X
File Edit Source Refactor Navigate Search Project Rum RV-Tools Window Help
&|[0][m] ORun @1 _helloworld_debug_ ® Run C+F fpigv @ r v @ v v O v Qv Qri®s &~ rHrGaerDy Quick Access| || = | &
—— = Debug | =
& Project Explorer © 8 @ Profile £ Qutline s B
« 1 helloworld
& Includes Profile Histary > An outling is not available.
application Profile As E
Debug Profile Configurations...
nuclei_sdk Run History B
1_helloworld_debug openocd Jaunch N
| Run Configurations... |
Debug History >
% Debug As >
Debug Configurations.
Breakpoint Types >
Toggle Breakpoint Ctrl+Shift+§
Ctrl+Alt+B
Breakpoints
A External Tools >
O Console # Ten 2 k=@~

CDT Build Console [1_helloworld]

21:37:11 **** Clean-only build of configuration Debug for project 1_helloworld ****
make clean

rm -rf . /nuclei_sdk/SoC/hbird/Common/Source/Stubs/close.o ./nuclei_sdk/SoC/hbird/Common/Source/Stubs/fstat.o ./nuclei_sdk/SoC/hbird/Common/Source/Stubs/gettimeofday.o ./nuclei_sdk/SoC/hbi

21:37:11 Build Finished. @ errors, © warnings. (took 171ms)

1 helloworld

Kl 6-3 & “Run Configuration” #:47 T #k
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@ Run Configurations | X
Create, manage, and run configurations @
(SR X[ B3~ Configure launch settings from this dialog:
type filter text | - Press the "New Configuration’ button to create a configuration of the selected type.
¢ Build Docker Image + _ Press the ‘New Prototype’ button to create..onfiguration prototype of the selected type.
] C/C++ Application , , .
1 C/C++ Container Lau | ™ Press the ‘Export’ button to export the selected configurations.
€1 C/C++ Remote Appl | [ - Press the 'Duplicate’ button to copy the selected configuration.
€0 C/C++ Unit % - Press the 'Delete’ button to remove the selected configuration.
© Docker Compose
P =D shambillombubtanda.configure filtering options.
v EIGDB OpenOCD Def ™ New Configuration . o
& hello_world deb % ew Prototype uration by selecting it.
€1 GDB PyOCD Debur .5 Export... nd then se..nk Prototype’ menu item to link a prototype.
E1GDB QEMU DEbeg Duplicate nd then se... Prototype’ menu item to unlink a prototype.
1 GDB SEGGER J-Linl i Delete
nd then se..s" menu item to reset with prototype values.
@ Launch Group i Link Prototype... * e
# Launch Group (Dey  ynjink Prototype
Launch over Serial | Racet with Prototype Values tings from the 'Perspectives’ preference page.
& Run Docker Image
< >
Filter matched 15 of 15 iter
@ Run Close
6-4 73T Y GDB OpenOCD Debugging
@ Run Configurations O x
Create, manage, and run configurations @
ER@x% Y Name: hello world_debug_openocd
type filter text || Main . Debugger|  Startup| + Source |l Comman % SVD Path
Build Docker Image
[© C/C++ Application
[ C/C++ Container Launcher Browse..
[ C/C++ Remote Application C/C++ Application:
© Docker Compose = =
« £ GDB OpenOCD Debugging Variables..  Search Project... Browse...
&l hello_world_debug_openocd Build (if required) before launching
E1GDB PyOCD Debugging Build Configuration: Select Automatically v
[ GDB QEMU Debugging
[ GDB SEGGER J-Link Debugging ) Enable auto build () Disable auto build
& Launch Group (®) Use workspace settings Configure Workspace Settings.
# Launch Group (Deprecated)
Launch over Serial
4 Run Docker Image
Filter matched 15 of 18 items Revert Apply

6-5 GDB OpenOCD Debugging £~ H T~ hello_world 5l H Debug
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€ Run Configurations

Create, and run

FPRaEXIB® -
type filter text
% Build Docker Image

Name: ‘ hello_world_debug_openocd
© Main | $ Debugger > Startup| & Source| = Common % SVD Path

X

TC/C o+ Applicati OpenOCD Setup A
e appcation ] Start OpenOCD locall
& C/C++ Container Launcher P Y -
1 C/C++ Remote Application Executable path: | ${openocd_path}/${openocd_executable} | Browse... Variables..
€1 C/C++ Unit Actual executable: C:\Users\24954\Desktop\NucleiStudio | DE}DZGOH\Nu(leiStudiuilDEﬁZﬂZUDB\Nu(IeiSIudin\\lDl
© Docker Compose . (to change it use the global or workspace preferences pages or the project properties page)
~ [ GDB OpenOCD Debugging GDB port: 3333 |
= hello_world_debug_openocd .
¥ GDB PyOCD Debugging Telnet port: 4444
E1GDB QEMU Debugging Tel port: 6666
< GDB SEGGER J-Link Debugging| - config options: |-f "nuclei_sdk/SoC/hbird/Board/hbird_eval/openocd_hbird.cig”|
& Launch Group
# Launch Group (Deprecated)
Launch over Serial Allocate console for OpenOCD Allocate console for the telnet connection
@ Run Docker Image GDB Client Setup
Start GDB session
Executable name:  ${cross_prefixjgdb${cross suffix} Browse... Variables...
P! 9 A |
Actual executable: riscv-nuclei-elf-gdb |
Other options: |
Commands: set remotetimeout 250 A
set arch riscvrv32 "
Remote Target
Host name or IP address: localhost
Port number: 3333
["] Force thread list update on suspend v
< >
Filter matched 15 of 18 items L= LB
® =
] 3
6-6 it & hello_world_demo Debug [1Z%] 1
@ Run Configurations =] ®
|
| Create, manage, and run configurations @
\
BRBNIER Name: hello_world_debug_openocd
type filter text I Main % Debugger » Startup - Source = Common = SVD Path
B:é'd f’:‘p‘:;{':;f Initialization Commands
/C++ Container Launche | LJnitial Reset. Type: ini
#1C/C++ Remote Applicatic
€ C/C++ Unit
© Docker Compose -
+ /GDB OpenOCD Debuggin| | £01e ARM semihosting
@ hello_world_debug_ops  Load Symbols and Executable
T GDB PyOCD Debugging | [+ Load symbols
 GDE QEMU Debugging (® Use project binary: hello_world.lf
I GDB SEGGER J-Link Debuc| () Use file: Workspace.. | File System
4 Launch Group .
& Launch Group (Deprecate,| >YMBels offset (hex):
Launch over Serial e
& Run Docker Image (®) Use project binary: hello world.elf
© Use file: Workspace..  File System._
Executable offset (hex):|
Runtime Options
Run/Restart Commands
Pre-run/Restart reset Type: halt|(always executed at Restart)|
[ set program counter at (hex):
/] Set breakpoint at: main
Continue
Restore defaults
< >
Filter matched 15 of 19 items Revert
@ e
s
K 6-7 ELE hello_world_demo Debug K)jZ:%5 2
> SN Mo shfl BN 2 R ~ YA K skl 4 - A FLEAE S Gt 52 > > N
ASCAF TR A B R B SR B , RGBT, AR, SR sl e A SO 2 ek . i 68
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6.1.3. R kAR B AREF
AR R AT, @ ZATIF 8 0 DMEUEE Printf o8 3037 HIE 2.
fi H Windows R Gt R L5500 7F -

B {TJT Nuclei Studio B ()5 HATERIEE, 1263 Window>Show View>Terminal, 41K
6-8 T, sl o s EIFRAT T BRI, K 6-9 s, fEH & HHiE Choose
terminal GZEFH M, B Serial Terminal) . “H 157 CGXHLPL COM11 A#D « “3
ke (E N 1152000 7 245, Hili “OK” %4,

8 CPDE - NucleiStudio = [l X
File Edit Source Refactor Navigate Search Project Run RV—IUUIsHeIp

%][G][=] ©Run @l hello_world_debug o b= New Window AR ECH AR RS Ad -0 ha Rel LT A4 -~ * D~ |Quick Access| | | B
& Project Explorer e S I Eritcy & ! & Outline

& hello world Appearance >

% Build Targets An outline is not available.

Perspective 5 & C/C++ Projects

@ Console Alt+Shift+Q, €
Navigation > m Documents
nuclei_sdk Preferences s e
hello_world_debug_openocd.launch € Mavigator
= Outline Alt+Shift+Q, O
@ Prablem Detalls
£ Problems Alt+Shift+0, X
& Project Explorer
O Properties
¥ Search Alt+Shift+Q, S

B Task List Alt+Shift+Q, K
Tasks
LLr_Terminal ] o

Other. Alt+Shift+Q, Q

G[~)

L Problems < Tasks ©Console ™ Properties &~ Terminal

6-8 ifiid Nuclei Studio T & MR B F A & S50
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@) Launch Terminal U X

Choose terminal: Serial Terminal ™
Settings
Serial port: [COM11 v
Baud rate: 115200 ™
Data size: 8 >
Parity: None ™
Stop bits: |1 >
Encoding:  Default (ISO-8859-1) &7

@ Cancel

6-9 WEH S
i/ Linux RGEFTF R DA T

B {77 Nuclei Studio H 7] Terminal ¥, %% Window>Show View>Terminal, #1F&
6-8 flin, midi et BIARTT D EiEi. Wk 6-10 s, choose terminal 14+
Local Terminal, i OK #] 7 Terminal &%, W& 6-11 ff7x, A “minicom
/dev/ttyUSB1 115200” #THFH 1, EITA7E Nuclei Studio H 2 F & LT EHIE E..

B Launch Terminal

Choose terminal: | Local Terminal -
Settings

Encoding: | UTF-8 M
® Cancel OK

AN PITIR A BB ER BT, RSP R TIRA, AMSAERR . S Sl e A SO 2 A iR sl A wE 70
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6-10 #TJT Terminal %

& hbird (ubuntu) 2

Welcome to minicom 2.7

OPTIONS: I18n

Compiled on Mov 15 2018, 20:18:47.
Port /dew/ttyUSBl, 14:38:85

Press CTRL-A Z for help on special keys

CTRL-A Z for help | 115280 8N1 | NOR | Minicom 2.7 | WT182 | Offline | ttyUSB1

B 6-11 47

R A e W iis AT T R AT KR AR, AT B H Nuclei Studio IDE #4711
tH T IDE 3247 T ML PC i, MARFIe T T IRAFF At b, B Rl iRy “fEL IR 5L
H IR .

iX B DL 1_helloworld A1, {#H Nuclei Studio IDE %} HummingBird SoC J& % I & ¥ i3k 4T

FELEA 2B BN R

B fifR 6.2 1) Debug W E N LM, W LAFTHF Debug W EETIHHIN. WK 6-12 f
7~, 1E 1_helloworld T# 447, %+ “Debug As —>Debug Configuration” 7
Debug 5 & k45 BT 2 M B d.

B EREILRG, £E 6-13 T HAEE T Debug, )5 2 EbraA 00 fulEbs, Hd
B AT 32E N R A O T 3R 3 E AT AR

ARSCAE PR A BRI SR B T, REERBHECER S T, AHERE. SR s i A S 2 il oy WA R 71



R
NUCLEI

€ CPDE - NudleiStudio - & x
File Edit Source Refactor Nevigate Search Project Run RV-Tools Window Help

%/ 0 = ORun ~ | T 1_helloworld debug -~ (=R4 BrA vy L@y RR | iR AT T T HETOTR YA YIS S x Quick Access| = | |Gl
& Project Explorer 7 E®ly “- 0o -o
+ 51 _helloworld

& Includes New > An outline is not available.
= application Golnto

# Outline ® B ar.. [

Open in New Window
Show in Local Terminal »
Copy ctrisC
Paste Ctrisv
® Delete Delete
Remove from Context Ctrl+Alt+Shift+ Down
Source »

Build Project

Clean Project

Refresh FS
Close Project

Close Unrelated Project

Build Targets >
Index ¥
Build Configurations »

T

31d of configuration Dsbug for project 1_helloworld *=**
::Z'“‘ﬂm" * lird/Common/Source/Stubs/close.o ./nucled_sdk/SoC/hbird/Common/Source/Stubs/fstat.o . /nuclei_sdk/SaC/hbird/Common/Source/Stubs/gettimeofday.o . /nucled_sdk/SoC/hbi
alidate

O Run As 3

o s 5] = 1¢/C++ Container Application
Frafle As % [ 2 Local C/C++ Application

Restore from Local History. Debug Configy

SDK Configuration Tools Ctrl+b

Run C/C+ + Code Analysis

Team >

Compare With >

a0

Configure »
Source »

Properties AltEnter

>
1 helloworld ¥

6-12 i “Debug Configuration” #:47 TN #;

8 CPDE - NucleiStudio

- o x

ile Edit Source Refactor Navigate Search Project Run RV-Tools Window Help

S[E) = #0ebug 11_helloworld_debug_~ | [ = B T T - TR T G VS S P ST S QPP 2 o Guick Access i = |8
a®le =0 & Outl =7 % Docy

& Project Bxplc o o Outline iid Tar... % Docur

~ & 1_hellow

& Bina

An outline is not available.
& Includes

& application

& Debug

& nuclei_sdk
1_helloworld debug openocd launch

roblems & Tasks @ Console : s &Terminal = Disassemt
COT Build Console [hello world]

9 R - R

0 items selected

6-13 Y% Debug fi=X
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B QR RS, WK 6-14 Frs, IFH2 B3RS .

@ NucleiStudio_workspace

e 6-14 B 1 SHRENE,

WK 6-14 ) 2 SR,

wE 6-14 1 3 ShpiEALE,

LA B 53

WK 6-14 11 4 ShREAE,

e 6-14 ) 5 ShMFN &,

WK 6-14 11 6 SHrEALE,
2 HT A EUE

WK 6-14 1) 7 ShRyEN &,

e 6-14 1) 8 SAMEAMER T, XEWLIE GDB £l 545

- MucleiStudio IDE

XEIR A AL,

B T S N [ /Y e W VA

1847, IS ZOREE

FEACHD 0 22 M0t RV AT A2 1247 BB K A, BRI AT BL

3% BT LAY 2 R A AT T AR

e R H N AL B R AL B

RERERTARSENCE. K ERZE PCHF

X B AR AT LR H R AR

AT B

- helloworld/application/main.c - s} *
File Edit Source Refactor Navigate Search Project Run RV-Tools Window Help L [+]
& |[®][®] ©Debug ~ Ehelloworld_debug_of - B BTOTAY ™5 v u_q,, B~ v (5 0O a =
Debuq & Project Explorer B 170 @mainc Emaine  ©(gdbl1]proci42000] threadGroupli1Lgdbl1]proc42000] OSthread 1]) thread(1] frame{0] T ofeve %B wE &M AP % 7 D)k Registers §eln=1=n0o
Ehelloworld debug openocd [GDB OpenOCD Debugaingl 65 if (misa bits.b.p) { ~ zalrie il IName
% helloworld.elf s , misa_chars[index++] = 'P'; Name Type 1
v #Thread #1 (Suspended : Step) o S i int ©
[ f bits.b -
= main() at main.c95 0xB0000fde =l (:i:-:;;s[l:leﬁ“l R o rval uint32 t 6
= openocd.exe o } - ! or misa st t i pe
2 riscv-nuclei-elf-gdb 71 if fmlsa_tnts b.u) { 0
- R misa_chars[index++] = ft1
if (misa_bits.b.v) { e
misa_chars[index++] = 'V'; 3
) it
if (misa_bits.b.x) { its
78 misa_chars[indexs+] = 'X'; ith
79 ft7
g8 s0
1 misa_chars[index++] = "\@';
o fs1
83 printf("MISA: RVEs\r\n", misa_chars); fa0
84 } fal
_ss fa2
= ?nt main(void) fa3
88 sran d(_get . :yclet) | _get_rv_instret() | _RV_CSR_READ(CSR_MCYCLE)); ;”;'
8 nt32_t A
%8 rv_csr_t misa = w CSR_READ(CSR_MISA); fab
a1 < H (N >
5. pr)néf( vrf,; exXIx\r\n", misa); Name : misa ""‘EH: p; s0000¢4
T . = print_misa Details:1075089769 lex:@x880807dc
@ Current Position ol efaulc:Le7ssssnes Decimal: -2147479588
o a5 for (dnt i = @; i < 20; i ++) { mal: 1875885709 0ctal:@20000007734
ek printf("%d: Hello World From Nuclei RISC-V Processor!\rin”, i); .m [g)@giqglzd Binary:18808088680B0000¢
© Break Point — 7Y Biary: 1080800606101001¢ Default: fde <mair
98 O:ta'l to1c00s110455
929 return @;
168 }
101
102 v
o < > e

AR N E RSO G RBHOM KA, REURBHRE I, AR sl e A2 A i sl A

Breakpoint 3, main (} at ../application/main.c:92

MMMMMM

o, pref o |_,1|$[ suffix) (722)

92 printf("MISA: 8xX¥lx\rin”, misa);
n

93 print_misa();

n

95 for (int i=0;i<20; i

) {
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6.1.4. TREBITERF

VAP A RIS, TRCE R T8I R WE 6-15, s FRMEDH 21T
X, Sbit 2o bR 2 V4o SR (g T3, Rl AU T BT kiR FE47 . TR~
BISAT AR FE B E S, PTUARERRE . WK 6-16, A LLE | H HIERTTEIH
helloworld %5 5. FHEWIIFER:, WK 6-17, 7E console ¥4 H T st 4 Bz EH Wi T Hz .

8 CPDE - NucleiStudio = [l X
File Edit Sou <en||Ng|smn|,|R RV-Tools Window Help
<= @ L. ellowortd debug o~ R T R - I WP E TS TG HTO TR idE S SRS Quick Access]| & |8l #
& Prjec b pl : = ° & OQutline ]
&Bi ebu An outline is not available.
9 Inc
nuclei_sc
1_helloworld_debug_openocd launch
B Console , : TET R

DT Build Console [nucleisdk]

K 6-15 TR R AR FIzeT
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@ CPDE - NucleiStudio - [l X
File Edit Source Refactor Navigate Search Project Run RV-Tools Window Help

%/[0][®] 0Run ~ | @ hello_world_debug ¢~ | '™ v B v R A B O N2 N D A E Y EvE v YO O YA SE S S [Quick Access|!| @ | B

& Project Explorer Esle ~=0 “ B =Outline = ¥ Task 1. %Dow. =8

~ & hello_world v
 Binaries An outline is not available.

) Includes

application

& Debug

nuclei_sdk
hello_world_debug_openocd.Jaunch

1% Problems < Tasks ©Console = Properties & Terminal ©
2coMn

Nuclei SDK Build Time: Aug 6 2020, 11:40:17
Download Mode: ILM

CPU Frequency 5001707 Hz

MISA: x4014912d

MISA: RV32IMACFDSPU

: Hello World From Nuclei RISC-V Processor!
: Hello World From Nuclei RISC-V Processor!
: Hello World From Nuclei RISC-V Processor!
Hello World From Nuclei RISC-V Processor!
Hello World From Nuclei RISC-V Processor!
: Hello World From Nuclei RISC-V Processor!
: Hello World From Nuclei RISC-V Processor!
: Hello World From Nuclei RISC-V Processor!
: Hello World From Nuclei RISC-V Processor!
Hello World From Nuclei RISC-V Processor!
: Hello World From Nuclei RISC-V Processor!
: Hello World From Nuclei RISC-V Processor!
: Hello World From Nuclei RISC-V Processor!
World From Nuclei RISC-V Processor!
World From Nuclei RISC-V Processor!
World From Nuclei RISC-V Processor!
World From Nuclei RISC-V Processor!
World From Nuclei RISC-V Processor!
wWorld From Nuclei RISC-V Processor!
World From Nuclei RISC-V Processor!

=R AR SN ] #e0

CHNONbUNES

BHEE R G E e
beloahbunibe?
Txxrrxx
TosmD 00
R R R RE
LEoEEED
65666560

Connected - Encoding: Default (ISO-8859-1)

6-16 & [ )T 5 i fa i 1 Hello World

@ CPDE - NucleiStudio - o X
File Edit Source Refactor Navigate Search Project Run RV-Tools Window Help

U & WP EAvErerGrikvOrRvATiS®

40 =] ORun ~ |1 _helloworld_debug_~ (=R g Bvy&vi@vioin
. Project Explorer 8%le == = O B OQutline & # Task List ild Tar.. %Docur - o
v & 1_helloworld o
& Binaries An outline is not available.
 Includes
application
& Debug
nuclei_sdk
1_helloworld_debug_openocd launch

Quick Access|:| & |+

£ Problems # Tasks © Console * [ Properties #Terminal = Disassembly % Progress
1_helloworld_debug_openocd [GDB OpenOCD Debugging] openocd.exe
(3276) hpmcounterllh (/32)
(3277) hpmcounterizh (/32)
(3278) hpmcounterish (/32)
(3279) hpmcounteriah (/32)
(3288) hpmcounteriSh (/32)
(3281) hpmcounter1sh (/32)
(3282) hpmcounteri7h (/32)
(3283) hpmcounterish (/32)
(3284) hpmcounter1dh (/32)
(3285) hpmcounter2eh (/32)
(3286) hpmcounter2ih (/32)
(3287) hpmcounter22h (/32)
(3288) hpmcounter23h (/32)
(3289) hpmcounter2ah (/32)
(3290) hpmcounter25h (/32)
(3291) hpmcounter26h (/32)
(3292) hpmcounter27h (/32)
(3293) hpmcounter2sh (/32)
(3294) hpmcounter29h (/32)
(3295) hpmcounter3eh (/32)
(3296) hpmcounter3ih (/32)
(3922) mvendorid (/32)
(3923) marchid (/32)
(3924) mimpid (/32)

(3925) mhartid (/32)
(a161) priv (/8)

6-17 THESERR L O L T 3
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6.2. M J-Link ARES/THE
6.2.1. %3 J-Link 3833+ RTT X

HummingBird Evaluation Board 32 ¥ f] J-Link . #ifE SEGGER & M J-Link UL [H
(https://www.segger.com/downloads/jlink/#J-LinkSoftwareAndDocumentationPack), & H
CHERIE RS T 8EBOHTIY J-Link 3X3)Jf 223 . VER, J-Link IR HE T v6.62 A

GRARAE A CVEAT AT ENS Y, ) ml DARSE AT JF 82 N2 . W RABAE ] J-Link (19 RTT 37 El4
H, IR PR .

FTIF 2407 TAE S B T, WK 6-18, fF “Resource” &I s i ZLAEFRIE () bR PLEFT T T
FERTAERI H . WE 6-19, 7£ “nuclei_sdk/SoC/hbird/Common/Source/Stubs” 4% N —
A~ “SEGGER” JCAF, B 3CA R FHRAFI RTT ARG SCA

& Properties for 1_helloworld O X
ty':)e filter text Resource Cyov
.@ Path: /1 helloworld
Builders .
C/C++ Build Type: Project
v C/C++ General Location: D:ACPDE\T_helloworld
Code Analysis Last modified: 2020585 6H T48:.06:48
Documentation Text file encoding
File Types (® Inherited from container (GBK)
Formatter O Other: |GBK
Indexer . i
Language Mappings [ Store the encoding of derived resources separately
Paths and Symbols New text file line delimiter
Preprocessor Include Pa | (@) Inherited from container (Windows)
Profiling Categories () Other: Windows
Linux Tools Path
MCU

Project Natures
Project References
Run/Debug Settings
Task Repository

Task Tags

Validation

WikiText
< > Restore Defaults Apply
@ Apply and Close Cancel

6-18 4T IF LEEFT#E H 3%
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¥ s | Stubs - O X
bl = = =A e
«~ v 1T « SoC » hbird » Common » Source » Stubs v O EFE"Stubs’ o

SEGGER  ~ @i ' i EIER sz
Syscalls [ secGer 2020/8/17 10:18 sl |
@ OneDrive ] close.c C 3z
) ] fstat.c C 344
= B +] gettimeofday.c C St
L EIBLE o isatty.c C 324
B asm o Iseekc C it
= EE «l read.c C 3744
3 i ..:sbrlb(.:] C 1‘
@] stub| H 3z¢
4 TH . an
wl write.c C 344
b ER
W =m
£ .9 Windows ((
«+ Data (D)
P s
< >
10 M8

6-19 #id “SEGGER” {3k

LIS AT IT J-Link KSR H3%, 4 “Samples -> RTT” #§42 ~ )
“SEGGER_RTT_V68od.zip” fft/k4f (BARELGE 4 T REARAA R ARL) o MR IE 485 301
W2 UIE 6-20, K RTT Xf43£ F ) “SEGGER_RTT.c” , “SEGGER_RTT.h” A
“SEGGER_RTT_Conf.h” =ANSCFLL K Syscalls U )
“SEGGER_RTT_Syscalls_ GCC.c” X204 & il 31| < Fi#r &2 i) SEGGER A erh, fx 5t
6-21 flisn. £ IDE 1§77 “SEGGER_RTT_Syscalls_GCC.c” , #E 6-22, 8 “#include
<reent.h>” Fr7ERIX—47
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| ¥ = | SEGGER_RTT_V680d - O X
*m  #z &8 )
« v 4 <« Jlink > Samples > RTT » SEGGER RTT V680d v 0 | EE"SEGGER RTT .. P
2020087 ~ &k : 1R IR e Foh
nuclei_ide Examples 2020/8/17 11:14 it
SEGGER RTT 2020/8/17 11:14 sk
SEGGER Syscalls 2020/8/17 11:14 s
L : ASSTRY
& OneDrive - License.txt 2020/5/25 22:54 AR
— README.txt 2020/5/25 22:54 SASTRY
W R
N EDE O
B
= Bl
x|
¥+ T
b aEx
W =\
£ 4 Windows (1
Snatama Y€ >
5 I ==
6-20 it N ST N2
J = |SEGGER - O X
« v « hbird » Common » Source » Stubs » SEGGER v U 1EBE="SEGGER" P
nuclei ide ~ %R ) EXE sem)
SEGGER ) SEGGER RTT.c 2020/6/28 15:41 c it
SEGGER ) SEGGER _RTT.h 2020/6/28 15:41 H 324
& OneDrive <) SEGGER RTT Confh 2020/6/28 15:41 H 3zi4
) SEGGER_RTT Syscalls GCC.c 2020/8/17 10:22 Cxzf4
= e o
B 3D &
L E
=Bk
& e
4 TF
D EE
W =m
% 9 Windows ((
« ' Data (D:)
L R ¢ >

/l 6-21 5l /5 SEGGER Pk 2
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- [« X

&
1 9

@ CPDE - 1_helloworld/nuclei_sdk/SoC/hbird/Common/Source/Stubs/SEGGER/SEGGER_RTT Syscalls GCC.c - NucleiStudio
File Edit Source Refactor Navigate Search Project Run RV-Tools Window Help
&|[%][m] +Debug 11_helioworld Debug o~ 5@ ~iein ¢ - = SO R O AUvING 4 widv v Quick Access|:| & | @&
 Project Explorer =% v & mainc EGGER RIT Syscalls GCC.c Slev " T 5 iRegisters = ¢ o -
~ & 1_helloworld 43 - LTS
 Binaries 44
# Includes 4
a6 *
& application 4
& Debug
~ & nuclei sdk
= NMSIS
v @ SoC
“ & hbird
& Board
v & Common
& Include
v & Source
& Drivers
= GCC
“ & Stubs
+ & SEGGER
5 SEGGER RTT Confh

5_GCC.c
tions for using prin
or printf output,

% SEGGER RTTh
: close.c
< fstat.c
¢ gettimeofday.c
2 isatty.c
: lseek.c
 read.c
& sbrkc
& stubh
< write.c
2 hbird_common.c
@ system_hbird.c
1_helloworld_debug_openocd Jaunch

reent struct
the used standard library.

@ Console

No consoles to display at this time.

Writable Smartinsert  61:1

Kl 6-22 FEREAEI ) Sk S0

IR INSE UG Wi SEGGER S #8814 2 include, 1E 6-23, T 401 TAER R E T
[f, ¥ SEGGER (A4 #%4£ % include 7,
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@ Properties for 1_helloworld X
type filter text Settings yeovs
Resource = = = = ~
Builders
v C/C++ Build

Build Variables

Environment

Logging

Settings

Tool Chain Editor
C/C++ General
Linux Tools Path
MCU
Project Natures
Project References
Run/Debug Settings
Task Repository
Task Tags
Validation
WikiText

® Tool Settings & Toolchains B Devices O Container Settings # Build Steps

<

<

<

<

<

<

<

% Target Processor

& Optimization

& Warnings

% Debugging

® GNU RISC-V Cross Assembler

Include paths (-1)

"${workspace loc;/${ProjName}/nuclei sdk/SoC/hbird/Board/hbird eval/Include}”
"${workspace loc;/${ProjName}/application}”
'$[w0rkspace_\oc:/${ProjName}/nucIe'\_sdk/NMSIS/Core/\nc\ude}'

Build Artifact [ Binary Parsers @ Error Parsers

'$[w0rkspa(e \0(:/${Pr0jName}/nucIe'\ sdk/SoC/hbird/Common/Source/Stubs/SEGGER}"

a8 8id

(2 Preprocessor
2 Includes
& Warnings

& Miscellaneous
® GNU RISC-V Cross C

Include system paths (-isystem)

aa il

(2 Preprocessor
& Includes
2 Optimization

2 Warnings

& Miscellaneous
& GNU RISC-V Cross C++ Compiler

22 Prep rocess:/

2 Optimization

2 Warnings
& Miscellaneous

> A Include & 1 B MISEGGER R k% 11

® GNU RISC-V Cross C++ Linker

Include files (-include)

aa il

2 General
& Libraries
& Miscellaneous
® GNU RISC-V Cross Create Flash Image
& General
® GNU RISC-V Cross Create Listing
2 General
® GNU RISC-V Cross Print Size
@ General

)

Apply and Close

Cancel

6-23 ¥sin SEGGER % #4122 Include +

T R R IR A 1) write B3, WK 6-24, {E

“nuclei_sdk/SoC/hbird/Common/Source/Stubs” T[] “write.c” /a4, &%

“Resource Configurations —> Exclude from Build” . #1& 6-25, %% “Select All” , fiid;
“OK” . PAJEan ARk [l fdi B & 4T ER, /] LU AR R 77 X Bk SEGGER U4 4T
“write.c” CHFAINIE] TR

AR N E RSO G RBHOM KA, REURBHRE I, AR sl e A2 A i sl A
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@ CPDE - 1_helloworld/application/main.c - NucleiStudio

File Edit Source Refactor Navigate Search Project Run RV-Tools Window Help

&|[#%][m] + Debug I1_helloworld Debug o
 Debug - Project Explorer New
~ & 1_helloworld Open

 Binaries Open With

# Includes

o Show in Local Terminal
« & application

Ctri+Alt+Shift+Down

S RN . SO HTOTATISE AT AT r3-
>
a_bits.b.s) {
a_chars[index++] = 'S';
>
5 fa_bits.b.p) {
a_chars[index++] = 'P';
Ctrl+C

CirliV | bits.b.t) {
Delete fa_chars[index++] = 'T';

a_bits.b.u) {
a_chars[index++] = 'U';

F2 ja_bits.b.x) {
a_chars[index++] = 'X';

F5 lars[index++] = "\0';

2 MISA: BUES\Cint misa chars);

4 main & Copy
= Debug Paste
v & nuclei_sdk ® Delete
NMSIS Remove from Context
v &Sl Source
~ & hbird Move...
 Board Rename
v & Common
Import.
include - g8
~ = Source
& Drivers Refresh
& GCC Index
~ & Stubs

=SECEE b iling Tools
close.c
fotare | Validate
gettie © SDK Configuration Tools
: isatty, ¥ Run C/C++ Code Analysis
lseek e Team

:readc  Compare With
Esbrkc  Replace With

Properties
= write.c
@ hbird_common.c
2 system hbird.c
1_helloworld_debug_openocd launch

< /1 helloworld/nuclei sdk/SoC/hbird/Common/Source/Stubs/write.c

6.2.2. HEH A B Debug Configuration

Exclude from Build...

Ctri+s —Bet_rv_cycle() | _get_rv_instret() | _RV_CSR_READ(CSR_MCYCLE));
t rval = rand();
t misa = _RV_CSR_READ(CSR_MISA);

"MISA: @x¥lx\rin®, misa);
isa();

Alt+Enter |t i =@; i < 20; i ++) {

}

return 8;

. I
GNU MCU Eclipse Packs console
Extracting devices & boards...
Mo installed packages.
Completed in lms.

2020-28-17 11:33:18
Extracting devices & boards...
Mo installed packages.
Completed in lms.

printf(“%d: Hello World From Nuclei RISC-V Processor!\r\n", i);

Q@ Consale

6-24 #T7F Exclude from Build

@ Exclude from build

O X

Exclude object(s) from build in the following configurations

Debug
Release

Select All Deselect All

Cancel

6-25 % write.c 30/

B AL E J-Link 0 T4k Debug Configuration #5540

- o b3
Quick Access|| | R
-y 5  WiRegisters = © % =
s=|r Name Value Descripti
Name Type Value
. R d=hd

AR N E RSO G RBHOM KA, REURBHRE I, AR sl e A2 A i sl A
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B ESEHAF LS “Run—>Debug Configurations” .

B K 6-26, TEFHIMIE LY, WEREA 4T TENIHAKENS, HERET “GDB
SEGGER J-Link Debugging” , ## “New Configuration” , ¥ 2 WA H #raH—4
WX H “1_helloworld Debug” , WK 6-27. #fiff “Project” +& 417 Z i T

&, “C/C++ Application” Hie#% 7 1R 0 75 2218 1) ELF 3.

@ Debug Configurations

Create, manage, and run configurations

L [E%~ Configure launch settings from this dialog:
type filter text
[ C/C++ Application
[ C/C++ Attach to Application
&1 C/C++ Container Launcher
[ C/C++ Postmortem Debugger | = - Press the ‘Duplicate’ button to copy the selected configuration.
[ C/C++ Remote Application
Ci C/C++ Unit
[ GDB Hardware Debugging
v [ GDB OpenOCD Debugging - Edit or view an existing configuration by selecting it.

- Press the 'New Configuration' button to create a configuration of the selected type.
[# - Press the 'New Prototype’ butten to create a launch configuration prototype of the selected type.

& - Press the "Export’ button to export the selected configurations.

% - Press the 'Delete’ button to remove the selected configuration.

v - Press the 'Filter' button to configure filtering options.

1_helloworld_debug_openoc| [ - Select launch configuration(s) and then select ‘Link Prototype’ menu item to link a prototype.
New_configuration

=] GDB PyOCD Debugging

=1 GDB QEMU Debuggin [® - Select launch configuration(s) and then select 'Reset with Prototype Values' menu item to reset with prototype values.
« |= GDB SEGGER J-Link Debuggina
= 1_helloworld Debug New Configuration gs from the 'Perspectives' preference page.

& Launch Group # New Prototype

# Launch Group (Deprecated) - Export..
Duplicate
Delete

[u - Select launch configuration(s) and then select 'Unlink Prototype’ menu item to unlink a prototype.

i Link Prototype...
Unlink Prototype
# Reset with Prototype Values

< >
Filter matched 16 of 18 items

@

Debug

L

Close

K 6-26 i J-Link Debug Configuration

ARSCAE PR A BRI SR B T, REERBHECER S T, AHERE. SR s i A S 2 il oy WA
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@ Debug Configurations

FoREXER

type filter text

[ C/C++ Application

[ C/C++ Attach to Application

&1 C/C++ Container Launcher

[ C/C++ Postmortem Debugger

[ C/C++ Remote Application

€ C/C++ Unit

[ GDB Hardware Debugging

£ GDB OpenOCD Debugging
1_helloworld_debug_openoc
New_configuration

=] GDB PyOCD Debugging

=] GDB QEMU Debugging

=1 GDB SEGGER J-Link Debugging
[z 1_helloworld Debug

& Launch Group

# Launch Group (Deprecated)

<

<

< >
Filter matched 16 of 18 items

Create, manage, and run configurations

Name:hﬁe\\owor\d Debug

[ Main . % Debugger| & Startup % Source T Common % SVD Path

Project:

| 1_helloworld |

Browse...

C/C++ Application:

| Debug\1_helloworld.elf |

Build (if required) before launching
Build Configuration: Select Automatically

(O Enable auto build
(® Use workspace settings

Variables... Search Project... Browse...

() Disable auto build
Configure Workspace Settings...

Revert Apply

6-27 Waf# Project A1 C/C++ Application 5 T —3

T Debugger #~H, UK 6-28.

Wik 1 547 E “Start the J-Link GDB server locally” #i%r.

o 5 B 1IE#i35 [ JLinkGDBServerCL.exe 1542,

3 TR HATEHNRZ, XHEELN3o7 AFI, HA N3o7 BIF] . wiffi A RV-STAR JF &
B, X HHN GD32VF103VBT6. Wi ] HAth - K& #5525 J-Link Support Device W 71, 454
R https://www.segger.com/downloads/supported-devices.php

4 ik “Interface” Ny JTAG,

ARSCAE PR A BRI SR B T, REERBHCR e P al, APHER. S HI sl A SO 2 2 sih o N .

“initial speed” N Auto.
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5 SN S HIA) GDB & — .

MRAEBRHIANE, il 6 SALE “Apply” /{7

@ Run Configurations

Create, manage, and run configurations

CReEX[E3~

7 Build Docker Image

1C/C++ Application

1C/C++ Container Launcher

JC/C++ Remote Application

i C/C++ Unit

» Docker Compose

7GDB OpenOCD Debugging
[1_helloworld_debug_openocd
[© coremark_debug_openocd
[ cos_debug_openocd
[ demodsp_debug_openocd
[c] demotimer_debug_openocd
[c] dhrystone_debug_openocd
[c] flashhelloworld_debug_openocd
[=] free_debug_openocd
=] helloworld_debug_openocd
= New_configuration
[= plic_debug_openocd
Ertth_debug_openocd
[ whetstone_debug_openocd

7GDB PyOCD Debugging

1GDB QEMU Debugging

71 GDB SEGGER J-Link Debugging
[c]1_helloworld Debug

i Launch Group

+ Launch Group (Deprecated)
Launch over Serial

# Run Docker Image

< >
Filter matched 28 of 30 items

Name: ‘LheHnwor\d Debug

[ Main|# Debugger - & Star‘[up} % Snurcsﬂ = Cnmmnn} % SVD Path]

J-Link GDB Server Setup

(1]
|/ Start the J-Link GDB server locall (2]

["]Connect to running target

Executable path: [ ${jlink_path}/${jlink_gdbserver}

Browse... Variables...

Actual executablel] C:/Program Files (x86)/SEGGER/JLink/JLinkGDBServerCL.exe

(to change it use the global or workspace preferences pages or the project properties page)

Device name: 9 Supported device names
Endianness: (@ Little () Big

Connection: ®Uuss OIP l—‘ (USB serial or IP name/address)

Interface: (OSWD (® JTAG

Initial speed: (® Auto () Adap ) Fixed kHz! o

GDB port: 2331

SWO port: Verify downloads [| Initialize registers on start
Telnet port: Local host only [ ] Silent

Log file: ‘ Browse...

Other options: ‘fsw'ng\erun -strict -timeout 0 -nogui

Allocate console for the GDB server

GDB Client Setup [5)

Allocate console for semihosting and SWO

Executable name: J${cross_prefix}jgdb${cross suffix}

Browse...| Variables...

Actual executable:friscv-nuclei-elf-gdb

Other options:

Commands: set mem inaccessible-by-default off

Remote Target
Host name or IP address: localhost
Port number: 2331

[]Force thread list update on suspend

Restore defaults

5]

I Apply I

Revert

@ Close
6-28 % & Debugger £2H A%
FTHF “Startup” ¥ H, & 6-29, itk JTAG/SWD Speed & Auto, “set Breakpoint at
main” , “Continue” , “Pre-run/Restart reset” 1 “RAM application” #&Ifi#zik, I+ HE

W/a)i% “Initial Reset and Halt” £,

AR N E RSO G RBHOM KA, REURBHRE I, AR sl e A2 A i sl A
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@ Run Configurations

Create, manage, and run configurations

CEeRX B2~

type filter text

<

<

£ Build Docker Image

[E1C/C++ Application

€1 C/C++ Container Launcher

[E1C/C++ Remote Application

€ C/C++ Unit

© Docker Compose

[£1GDB OpenOCD Debugging
£ 1_helloworld_debug_openocd
[ 2_helloworld_debug_openocd

[E1GDB PyOCD Debugging

=1 GDB QEMU Debugging

[ GDB SEGGER J-Link Debugging
=1 1_helloworld Debug

& Launch Group

X

Name: ‘1_he|\0w0r\d Debug

B Main | % Debugger | & Startup
Initialization Commands

& Source| ™ Common| £ SVD Path

[ 1Initial Reset and Halt Type:

Low speed: 1000 kHz

JTAG/SWD Speed: ® Auto () Adaptive () Fixed

kHz

Enable flash breakpoints

Enable semihosting Console routed to: ] Telnet /] GDB client

Enable SWO CPU freq: |0

Hz. SWO freq: 0 Hz. Port mask: Ox1

Load Symbols and Executable
Load symbols

(® Use project binary: 1_helloworld.elf

& Launch Group (Deprecated) (O Use file: Workspace... = File System...
) Launch over Serial Symbols offset (hex): |:|
4 Run Docker Image Load executable
(® Use project binary: 1_helloworld.elf
(O Use file: Workspace... = File System...
Executable offset (hex): |:|
Runtime Options
I] RAM application (reload after each reset/restart) |
Run/Restart Commands
Pre-run/Restart reset Type: | \ (always executed at Resta rt)l
["]Set program counter at (hex):
Set breakpoint at: main
Continue
Restore defaults
Filter matched 17 of 20 items Reverr Apply
@ Run Close

K 6-29 & & Startup 2 H W%

LB ENE
I

6.2.3. £ RBFF R IR EIERER

SRR, MRS N Apply (RIE R E, WIREE RS S 7 close

ff i} J-Link £ HummingBird Evaluation Board i 75 ZiE B L. 0 6-30, ZLAERRER
#hr72 J-Link 75 BERE IR FRIER . Hoh VTref 21 1 V3.3 30, HAhH %853
JTAG #: 11, F5| ML EAEsd, —— RO, &5 SEVEHE 6-31.

ARSCAE PR A B FIRABUN SR B T, RGBS B, AHERE . S sl e A S 2 e WA
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VTref 1(e] e2 [NC
nTRST 3@ [®4 |GND
TDI 5 ® 6 |GND
™S 7E| ® 8 |GND
TCK 9 ® 10| GND
RTCK I:u ® @ 12|GND
TDO 13[0] e 14|=x
RESET 15 @ ®16|*
DBGRQ 17 @ ®18|x
5V-Supply (19 ® ® 20| *

6-30J-Link 5| #El

J-Link VTref Pin Connection

NN & T

6-31)-Link sE¥E# A

AR N E RSO G RBHOM KA, REURBHRE I, AR sl e A2 A i sl A i 86
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FETT R BV R/, WA B T, REERE JTAG B & OISR A S FALE,
FHATIT R 1 DME NS Printf sREHTENE B WRAEH RTT 4TE1, 75 247JF J-Link RTT Viewer &
F printf TEME B WK 6-32, #&MEHNERE, 13 USB J7:Ui##HE. Specify Target Device
RAEAE I N R 1B 28, X LL N3o7 M|, Target Interface & Speed & N 1000kHz,
P S b S R 1E 2. RTT Control Block %% Auto Detection.

J-Link RTT Viewer V6.80d | Configura... ? X

gnnection to J-Link

[ ] Serial No

() TCP/IP
() Existing Session

Specify Target Device
N307 v

Script file (optional)

Target Interface & Speed
JTAG ~ 1000 kHz -

h ontrol Block
() Address () Search Range

J-Link automatically detects the RTT control block.

0K Cancel

K 6-32 W& RTT Viewer

K 6-33 1 NAEL H Debug, 2 Ja e EbR A0y AU bs,  Fl BT RTE N R R I R
BREFREANTT R

IR TR, WA 6-34 s, JFH 2R st .

AR N E RSO G RBHOM KA, REURBHRE I, AR sl e A2 A i sl A Wi 87
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Nl 6-34 11 SAMEME, XEIHRAUMHL, 817, LMPHRE.

Wl 6-34 1 2 SEEME, XAHERER IR FIEITALE .

Wk 6-34 1) 3 SAREME,
W7 Ao

FEACHH ) 22 A0 Xty R AT AE AT BB i, PR ORI LB

mE 6-34 1 4 ShRiEAE,
W 6-34 1) 5 SAREME,
K 6-34 M) 6 SHriEALE,

W 6-34 17 ShaiEALE,

3 HL AT BAYT) e G R A R AR 2
RERZRBALE RN E .
XHEREE TR EEE .

s il 3 FRLZT g B0 AT AR HY R AR 2

ke 6-34 it 8 SHRERLE N7, XHEATLAME GDB %l & 15 2 24T 1.

@ CPDE - 1_helloworld/application/main.c - NucleiStudio
File Edit Source Refactor Navigate Search Project Run RV-Tools Window Help

3 =] + Debug

Project Explc o o

& 1_hellow
€

1_helloworld_debug_openocd launch

AR N E RSO G RBHOM KA, REURBHRE I, AR sl e A2 A i sl A

) 1_hefloworld Debug Bv&vL@von VR EE TG HvO Rl v Ui NE vt [ He D i
5 @mainc = Outline

if (misa_bits.b.s) { X
misa_chars{index++] = 'S'; u stdioh

gf(' bits.b.p) { o timeh
misa_bits.b.p
misa_chars(index++] = 'P'; u stdlibh

)  nuclei_sdk_soch

if (misa_bits.b.t) { * print_ misa(void)
misa_chars[index++] = + main(void) : int

}

if (misa_bits.b.u) {
misa_chars(index++) = ‘U';

}

if (misa_bits.b.x) {
misa_chars[index++] = ‘X

}

misa_chars[index++] = '\@';

printf("MISA: RVEs\r\n", misa_chars);

§3-int main(void)
9¢
srand(__get_rv_cycle() | _get_rv_instret() | __RV_CSR_READ(CSR_MCYCLE));
uint32_t rval = rand();

rv_csr_t misa =

printf("MISA: exXlx\r\n", misa);

© Console
CDT Build Console [1_helloworld]
19:15:38 **** Incremental Build of
make all
Invoking: GNU RISC-V Cross Print Size

RV_CSR_READ(CSR_MISA);

configuration Debug for project 1_helloworld ****

riscv-nuclei-elf-size --formatsberkeley "1_helloworld.elf"

text data bss dec
8394 112 3448 11954
Finished building: 1_helloworld.siz

19:15:38 Build Finished. @ errors

hex filename
2eb2 1_helloworld.elf

, @ warnings. (took 325ms)

Writable Smart Insert  95:1
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@ NucleiStudio_workspace - helloworld/application/main.c - NucleiStudio IDE
File Edit Source Refactor Navigate Search Project Run RV-Tools Window Help

0

%[ [®] #Debug  ~ Ehelloworld debug of~ =+ [+ wvrovavessvsafrienan TeE TE]weil iy .o |m
#Debug = & Project Explorer o amainc # Emainc  ©(gdbl1Lproci42000] threadGroupi1lgdb|1]proc[42000) OSthread(1]) thread( 1] framel0]
+ Ehellowerld debug openocd [GDB Open0CD Debugging) i (misa bits.b.p) {

~ & helloworld.elf
« # Thread #1 (Suspended : Step)
= main{) at main.c95 0x80000fdc
£ openocd exe
2 riscv-nuclei-elf-gdb

}
if

}
if

73 }
74 if
o 3
77 if
78
s}

mis

pri

@ Current Position N

5
© Break Point—"" }

ret

BConsole P
helloworld_deb
Breakpoint 3
92

6.2.4. TREITERF

misa_chars[index++] = 'P';

(misa_bits.b.t) {
misa_chars[index++] = 'T';
(misa_bits.b.u) {

misa_chars[index++] = 'U’;

(misa_bits.b.v) {
misa_chars[index++] = 'V';

(misa_bits.b.x) {
misa_chars[index++] = 'X';

a_chars[index++] = "\@';

NtF("MISA: RVEs\r\n", misa_chars);

main(void)

srand(__get_rv_cycle() | _get_rv_instret() | _RV_CSR_READ(CSR_MCYCLE));
uint32_t rval = rand();

fy_csr_t misa = _RV_CSR_READ(CSR_MISA);

printf("MISA: @x¥1x\rin", misa);

print_misa();

for (int i = @; i < 20;

) {
printf("%d: Hello Hor‘ld From Nuclei RISC-V Processor!\r\n", i);

urn @;

)

roblems @ Executable] @ Debugger Consale = | Memory
ug_openocd [GDB Opert ol STerons, prefixjgdb(cross suffix) (227)
192

, main () at ../applica
printf("MISA: @x¥1x\r\n", misa);

print_misa();

for (int i = 8; i < 20; i ++) {

K 6-34 T E N R T

Type
int

uint32_t
v esrt

Name
i
o rval
o misa

<

Name : misa
Details: 1875889782
Default:1e75e897e9
Decimal: 1875883789
Hex:@x4014912d
Binary:1000000000101001¢
Octal: 018885118455

“Registers
Mame
t4
5
16
e
o
it
itz
3
it
its
6
it
fs0
sl
fa0
fal
fa2
fa3
fad
fas
faf

lame : pc
Hex:@:
Decim
Octa.
Binar
Defau:

x80000fdc
al:-2147479588
1820000007734

"y : 1822000088800008¢
1t:exseeeefdc <mair

;
o@e- -

VAR WIS, TSR FEETT R L. W 6-35, AUk FRAEDI# a2 7k

Ao BRI 22 B br 2 D)oy 2R

iBATHAE, BRI AR R EE I R RORE

N— S

&7

BT AT

AT AHFE BB S, FTUATREHREE. WK 6-36, A LLFEF| RTT Viewer 1EHFTED H

helloworld %5{5 2. R T LW, @E 6-37, £ console £~ H

.

N e 2L BH B AT

AR N AU SRR R A

REEARRH IR, ALk, =l

EREA S 2 2R N &

TS 89
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@ CPDE - 1_hellowa ication/main.c - NucleiStudio - =/

File Edit Source Refa

ate Search Project Run RV-Tools Window Help

#][0Run 1 helloworld Debug - Sv&vi @O OB Ol N0k A BD A SN el
Project Explge=s main.c Outline
« &1_hellowdemm if (misa_bit (

dex+s] = 'S7; = stdioh

& Binarie * Debug . misa_chars N
Includes SR u timeh
application misa_chars(ind@++] = 'P'; u stdiibh
mainc u nudlei sdk soch
Debug « print_misa(void) : void
~ & nuclei_sdk =T * main(void)
NMSIS

Soc

1_helloworld_debug_openocd.launch

misa_chars[index++] = '\0';

printf(“MISA: RVEs\r\n“, misa_chars);

int main(void)

srand(_get_rv_cycle() | _get_rv_instret() | _RV_CSR_READ(CSR_MCYCLE));
ui al = rand();
SR_READ(CSR_MISA);

printf( n", misa); v

eley "1_helloworld.elf"
hex filename

8394 112 3448 11954  2eb2 1_helloworld.elf
Finished building: 1_helloworld.siz

19:15:38 Build Finished. @ errors, © warnings. (took 325ms)

Writable Smart Insert | 78:32

6-35 N ERE T EIT AR PIEAT

J*L\'nk RTT Viewer V6.80d — O e

File Terminals Input Logging Help
411 Terminals Terminal O

Nuclei SDK Build Time: Aug 17 2020, 18:52:11
Download Mode: ILM

CPU Frequency 5060724 Hz

MISA: ©x4014912d

MISA: RV32IMACFDSPU

: Hello World From Nuclei RISC-V Processor!
Hello World From Nuclei RISC-V Processor!
Hello World From Nuclei RISC-V Processor!
Hello World From Nuclei RISC-V Processor!
Hello World From Nuclei RISC-V Processor!
Hello World From Nuclei RISC-V Processor!
Hello World From Nuclei RISC-V Processor!
Hello World From Nuclei RISC-V Processor!
Hello World From Nuclei RISC-V Processor!
Hello World From Nuclei RISC-V Processor!
: Hello World From Nuclei RISC-V Processor!
: Hello World From Nuclei RISC-V Processor!
: Hello World From Nuclei RISC-V Processor!
: Hello World From Nuclei RISC-V Processor!
: Hello World From Nuclei RISC-V Processor!
: Hello World From Nuclei RISC-V Processor!
: Hello World From Nuclei RISC-V Processor!
: Hello World From Nuclei RISC-V Processor!
: Hello World From Nuclei RISC-V Processor!

POUONOURAWNRE®

| Enter Clear

Temp. halted CPU for
HW instruction/
Support set/clr BPs while running:

HW data BPs trigger befo ution of inst

ATT Viewsr connected. 0. 004 NB

Kl 6-36 FTEN4iH Hello World

ARSCAEPITIR A BRI SR B T, RGP

SHIHEAL, AHERE . ST BB R A S 2 2R el

B

553
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@ CPDE - 1_helloworld/application/main.c - NucleiStudio u] X

File Edit Source Refactor Navigate Search Project Run RV-Tools Window Help

4//0 (=] ORun 0 1_helioworld Debug oy Bvavi@®vON - LW P AvEvEvEvT HvOTR YAy ST~ « 4 v §iwe vow Quick Access|: @ | &
Project Explorer v 4 main.c = ©10x200001ca Outline

~ & 1_helloworld 62 if (misa_| bxts b.s) { ~ AR e m|w
~ 63 misa_chars(index++] = 'S'; @ s

i( ( bits.b.p) { timeh
misa_bits.b.p
misa_chars[index++] = ‘P u stdiibh

} nuclei sdk soch

if (misa_bits.b.t) { = print_misa(void) : void
misa_chars[index++] = 'T'; = main(void)

if (misa_bits.b.u) {

misa_chars(index++

<

1_helloworld_debug_openocd launch 73 }
7 if (misa_bits.b.x) {
misa_chars[index++

}

misa_chars[index++] = "\@';|

printf("MISA: RVEs\r\n", misa_chars);

83-int main(void)

srand(__get_rv. y le() | _get_rv_instret() | __RV_CSR_READ(CSR_MCYCLE));
uint32 ¢ rval =
rv_csr_t misa = RV CSR READ(CSR_MISA);

printf("MISA: @x%lx\r\n", misa); v

1_helloworld Debu gmuﬁskoutm Link Debugging] JLinkGDBServerCLe:
Downloadin, ng 460 bytes @ address ©x2@000000 - Verified OK
Downloading 7486 bytes @ address @x20000200 - Verified OK
Downloading 528 bytes @ address 8x20001EF@ - Verified OK
Downloading 112 bytes @ address 0x20002100 - Verified OK
Comparing flash  [...o..cevvveernnnnns ] Done.

Writing register (pc = @x200@0@cc)

Received monitor command: regs

X = 00000000, X1 = 00000000, X2 = G00O0000, X3 = 0000000
X4 = 00000000, X5 = 00000000, X6 = 00000000, X7 = 00200000
X8 = 00000000, X9 = PAOGG0E, X10= 0OB0E000, X1l= 00800000
X12= 00000000, X13= 00000000, X14= 00000000, X15= 00000000
X16= 00000000, X17= 00000000, X18= 00000000, X19= 00000000
X20= 00000000, X21= 00000000, X22= 00000000, X23= 00002000
X24= 00000000, X25= 0000A0G, X26= AOREGR, X27= 0GBEEE00
X28= 00000000, X29= 80000000, X30= 00000000, X3l= 80020000
PC = 200000CC

Reading all registers

Starting target CPU...

Writable Smart Insert 78:32

6-37 T ST R AL (S L T R

7. A IBRRA Nuclei Studio A& K TE

Nuclei Studio M 2020.08 AT 4G, B 7 L BB M GNU MCU RISC-V GCC (riscv-none-
embed-gcce) F+ 4% 21| RISC-V Nuclei GCC (riscv-nuclei-elf-gee), K NgmiFargt kA2, AT LMEH
201909 K 2 BIHA R IDE A T2, 2R E 54 7T AIEH A IDE . x5 LA
201909 fii A< f¥] Nuclei Studio 4 i f¥) helloworld T %, HS N BB E K VEH D BATF

B 5\ 201909 RAA A helloworld TR, A SATTRIESH 4.2 1, XEAMIE

B FALREEALERE “Properties” FTJT W E WA, ##F “C/C++ Build - Settings” ,
$TFF Toolchains £ H 4R J5 /&4 Name F kTl “RISC-V Nuclei GCC (riscv-nuclei-elf-
gee)” , WfR. 1B2E R Apply RAFIZ L.

ARSCAE PR A BRI SR B T, REERBHCR e P al, APHER. S HI sl A SO 2 2 sih o N . Wi 91
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@ Properties for hello world O X

Settings —

Resource

Builders

C/C++ Build Configuration: Debug [ Active ] ~ | Manage Configurations...
Build Variabl

Envi t .
nvironmen ® Tool Settings ® Toolchains M Devices O Container Settings # Build Steps  Build Artifact & Binary Parsers @ Error Parsers

Logging
Name: RISC-V Nuclei GCC (riscv-nuclei-elf-gcc) VI
Tool Chain Ec Architecture: RISC-V v
C/C++ General
Linux Tools Path | Prefix:
M suftc [ ]
Project Referenc i
Run/Debug Sett C++ compiler:
Task Repository Archiver: ar
Tas.k Tags Hex/Bin converter: |objcopy
Validation Listi tor: bid
WikiText isting generator: |objdump

Size command: size

Build command:

3
2
=~
o

Remove command: rm

Toolchain path: ‘$€e(\Tpse_hume)\\toolchain\\gcc\\bin |

(to change it use the global or workspace preferences pages or the project properties page)

Build tools path: ‘$€ec\Tpseihome)\toolcham\bui\dftools\an |

(to change it use the global or workspace preferences pages or the project properties page)
[“] Create flash image

Create extended listing
Print size

< > Restore Defaults Apply
@ Apply and Close Cancel

B 7-1 &% Nuclei Studio T.E.%%

B B4 TR “Clean Project” Fi%k#¥ “Build Project” EH],

8. H L) &
8.1. Nuclei Studio Ezh18

Nuclei Studio /&% T eclipse #:1THF &, 487K T eclipse (IR H &M HIHRF M & RIS, HAFAE
F AR R, 5B, PR RR BRI AR ISR A7 S B Workspace.
£ 2021.09 i) Nuclei Studio ', FATEIXSJE a0 7O, 7ERMIERE 2 HIATIR T, 5 —IK)a
3] Nuclei Studio GE1E— 735 N 578 il

Nuclei Studio F iz 7 5.

ARSCAE PR A BRI SR B T, REERBHCR e P al, APHER. S HI sl A SO 2 2 sih o N . T 92
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B  Windows 10 #:1/E &%

B 4G UL EWAE (2G AT LA Nuclei Studio 43l % H )

8.2. Nuclei Studio iFfEFRIE

FEM A AR, AT I Nuclei Studio 7£4w P50 H I 2> H IR R I, Gl fFak
L, N 360 AREEHAER, HIFERSPIUTIRIE, 1B 360 REEHIFNT, FiiEfES DL IE

HOEEAT . 9 T PRFE Nuclei Studio MIEH ], @AEM IR H 360 F55% 74 AT

8.3. IT7F /<M Launch Bar

A “Window -> Preferences” , ##% “bar” , W@ 8-1, HUVHAESE — SR AJ

<M Launch Bar. [F#, #EZ/{#H Launch Bar ThiE, &2 %,

= Preferences

m Launch Bar

RurE/Deb:_g Preferences for the Launch Bar
w Launching
[ E Enable the Launch Bar |l

@ 2 "bar" (2 SR RABYE D

< >

_ .
@ s @®

Enable the Build button
[] Always show\the target selector

Restore Defaults

Apply and Close

Apply

Cancel

8-1 3£ Launch Bar

8.4. f#iH Launch Bar

Smartchip Studio 1) Launch Bar (i 5 UHE P FRVEFT 7)) A2 5320 T FAE Ak b i i ik

ARSCAE PR A BRI SR B T, REERBHECER S T, AHERE. SR s i A S 2 il oy WA
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o BN B TRESEAT g i, AR R 3B EERE, WFR A EER, Bise 5 NhAEA i
BoE N AMYE. FHELN4H Launch Bar %5843 ThRE:

“"% \_gj m | | O Run [c] helloworld_debug_openoc GJG
0- = 9!:! B
o,

&5 Project Explorer @ Run =

»i=helloworld 1% Debug

8-2Launch Bar Zfg/- 28

BIAR 1 i iRade A 0 VR B N I TR . A ik TR 9 TR 5 5 N RrAEE Hh 1 v i
N TF%, FF3F Project Explorer H1ik 1K) T/

Elbr 2: 1247 /g TR B NI TR . BRAEEIRR R N HHE 4 N R4
EIbR 3: 1B H T /R .
NHIHE g VI T E/ AR Ve S ScR B 2 IBRNE.
NHAE 5: G AR E SO AR AR EAR 1. 2. 3 RN TR
WA EIAS 6: ATJF 4Tk B RC B 0w, 7 BT B R AR
8.5. A#H Launch Bar #1747 /R

XTT RV E) TR, R AMEH Launch Bar Thfg, 77 LA THE, #%4#% “Debug As ->
Debug Configurations” . £ & F1 365 TR M (1% B kT, X B LA helloworld A %1,
K 8-3, i%&#% “helloworld_debug_openocd” , ZJ5i%# “Debug” FHiH1HIR.

FH, ¥IKisfTHEA G TR, %% “Run As -> Run Configurations” . £ 3 % thi%k £ T
TR BRI, 2 f5iETE “Run” FFARIZAT.

ARSCAE PR A BRI SR B T, REERBHCR e P al, APHER. S HI sl A SO 2 2 sih o N . T 94
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€ Debug Configurations J X
Create, manage, and run configurations ﬁ\
[ BeEXBY - Name:|hel\oworld_debug_openocd ‘
‘type filter text ‘ E Main - # Debugger # Startup|% Source ™ Common 7. SVD Path
~ [E C/C++ Application Proiect:
helloworld.elf s
[ C/C++ Attach to Application |hE”0W0”d Browse..
[E] C/C++ Container Launcher C/C++ Application:
[ C/C++ Postmortem Debugger |Debug/he\|0w0r\d.e\f
[ C/C++ Remote Application : -
€ C/C++ Unit Variables.. | Search Project... Browse...
@ Debug Adapter Launcher Build (if required) before launching
@ DSF PDA Application Build Configuration: Select Automatically v
[ GDB Hardware Debugging
& GDB Jumper Debugging (O Enable auto build (O Disable auto build
+ [ GDB OpenOCD Debudain (® Use workspace settings Configure Workspace Settings...
I helloworld_debug_openocdl 0
GDB PyOCD Debugging
= GDB QEMU Debugging
[ GDB SEGGER J-Link Debugging
A Launch Group
Filter matched 17 of 17 items Re‘é“ Apply
® Close

K 8-3 AM#iF Launch Bar 1 i 7L
254 RT TRE C A_L RHATI ASOE TR e, AIE Loy fek e T i R Rk, 4k
SRR R TAE R B BT . X T84T, WTRE © 7 B TFROET, PRosk En MR E
8.6. Debug MH&EE #F175%
Bt Debug #i30 )5, FIAEA LT TH FEARRESE — ]33], X BB EFAEEEH A, £35
Bk “Window -> Show View -> Registers” I H#FfE284= H . [FIFE, WRBEEERNIE, AL

% “Window -> Show View -> Memory” , A$TH =6 G, TLUESE “Window -> Show
View -> Debugger Console” , HAh i MLANAHOTE 2 /20, W H P BATARL .

8.7. Debug WHE R

7t Debug U EIR H A, Al Sd ® B IR, AP IEFT 2 AR S EERES, 75 Debug
W, Adi Debug £2H dff)kfE, £ “Terminate / Disconnect All” S5/ Debug #fE.

ARSCAE PR A BRI SR B T, REERBHECER S T, AHERE. SR s i A S 2 il oy WA i 95
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8.8. Nuclei Studio TR#=rdX T8k
{£ Nuclei Studio 1, & WK THRFERT, ATERHK IR 285160 1 DI RE -
milh g BvA TR EvTE Y IO YO TE YU viOD S/ SRE T DIn|SBBErHyeorOy |

T IR e ]
- e ®
RS RTSE  RURAE TG Rt
PR E © 7, BRI Debug Al Release, FSTAT TR, X B,

w

Ui TS S , W] DALE R H7 ik 35 4 % Project Explorer 73k 1) TF2.

GrEHTE A ™, — Wi BB Project Explorer 41 T 2.

wang® Y EY YOV e rmone, AR, CHRIRARAE.
Pt T, AT U R VR AR ) TR

1517 O, TR TR R A B BRI TR

Profile ©° 7, f/ Profile S, HALH, AR,

o @~ ‘ -
HraxeXTH , WL A, P E SIRAF A .

ARSCAE PR A BRI SR B T, REERBHECER S T, AHERE. SR s i A S 2 il oy WA i 96
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= =

2T A T R RITLS, A,

o § & E 1w e et
AT BE L A , A LR IT T B ARSI

pla T RS BT A G o 14,

[::-

8
Debug ] | s ATE BRI BT A W, )5 SE I Restart Zhfg.

7% CMSIS %, eclipse H7 ThAE, A CH

Nuclei SDK T2 % & T. B @ , Z M 5.1,

- v IO oow v|‘

=
A T A T, WTRBEPUEB, ARThRg AR

EZIAEP

8.9. ExRHMED

6 TDE f A = B er LR i Bk, H 02 C/C+ ST Debug B It
1, fEiE N Debug U, #AFE Debug WiH, <A MEIER, M A “Switch” EITA LA
J)#: % Debug T . fESEHFLHIESE “Window -> Perspective -> Open Perspective” 7] DL
PIE SN IEP

HEARFEKEA T, “Window -> Show View” BRI E B AR . Uik 8-4, {F Debug
W O] DUE R R R i 785 (Registers) , WA7F (Memory) Fifikizdl& (Debugger

Console) .
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Window Help
i New Window a | | Fl ot B
Editor >
Appearance >
Show View > % Breakpoints Alt+Shift+Q, B
Perspective 5 B Console Alt+5hift+Q, C
L + Debug
Navigation > @ Debugger Console
Preferences & Debug Sources
= Disassembly
% Error Log Alt+Shift+Q, L

O Executables

@ Expressions

0 Memory

0 Memory Browser

= Modules

g Outline Alt+Shift+Q, O
Peripherals

Problems Alt+Shift+Q, X
Progress

Project Explorer

! Registers

5 Signals

& Templates

& Terminal

% Trace Control

- Variables Alt+Shift+Q, V
2 Visualizer

Other... Alt+5hift+Q, Q

E P 0 R

8-4Debug HAEE I EEE 1

8.10. IKEBINE A H

AR “Window -> Perspective -> Reset Perspective” , 7E#E 1% “Reset
Perspective” 1] DL & & 11 BRIAAR )&

8.11. XLk jase et

FHiEEE LR, %8 “Compare With -> Local History” 1 7F7 82id 5% . W1
8-5, (EFTJFHY History 4% H Uy i B E X b B9 SCHE g S RRAS, ] LA B SO 8l 5 5
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[¢ mainc  &°Compare main.c Current and Local Revision & = =
[ C Compare
v [@ Translation Unit

° print_misa

9 C Compare Viewer £ MBE4ndR
Local: main.c Local history: main.c 2020561283300 T42:33:30
4#include <stdlib.h> 4#include <stdlib.h> ~
S#include "nuclei_sdk_soc.h” S#include "nuclei_sdk_soc.h”
6 6
7void print_misa(void) 7void print_misa(void)
8{ 8{
9 CSR_MISA_Type misa_bits = (CSR_MISA_Type) _ RV_CSR_READ( 9 CSR_MISA_Type misa_bits = (CSR_MISA_Type) _ RV_CSR_R
1e static char misa_chars[30]; 10 static char misa_chars[30];
11 uint8_t index = ©; 11 uint8_t index = ©;
12 if (misa_bits.b.mxl == 1) { 12 if (misa_bits.b.mxl == 1) {
13 misa_chars[index++] = '3"; 13 misa_chars[index++] = ‘3‘;
14 misa_chars[index++] = '2'; 14 misa_chars[index++] = '2"
15 } else if (misa_bits.b. mxl 2) { 15 } else if (misa_bits.b. mxl == 2) {
16 misa_chars[index++] = 16 misa_chars[index++] = "
17 misa_chars[index++] = 17 misa_chars[index++] = H
18 } else if (misa_bits.b.mx ) { 18 } else if (misa_bits.b.mxl == 3) {
19 misa_chars[index++] = 19 misa_chars[index++] = 'L";
20 misa_chars[index++] = 20 misa_chars[index++] = '2";
21 misa_chars[index++] = '8"; 21 misa_chars[index++] = '8";
22 )3 3
[ 23] b7 23 if (misa_bits.b.i) {
24 if (misa_bits.b.i) { 24 misa_chars[index++] = 'I";
25 misa_chars[index++] = 'I"; 25 ¥
26 } 26 if (misa_bits.b.m) {
27 if (misa bits.b.m) { 27 misa charsfindex++1 = 'M": 4
< > < >

¥ Problems ¥ITasks & Console = Properties & History #
main.c
Revision Time

= 2020/12/31 £510:22

= 2020/12/31 £E49:30

= 2020/12/31 £549:29

= 2020/12/30 F42:33

B 8-5 Xf kb s

8.12. FTE THEM 7l At tH PR 4

B THER IDE FRER A TR, R ENER TN AR RV ZE, 7]
S BRIP4 error, K545 JE error 2iE . WHILCA EILS, 1K DA & A i d N
.

8.13. #¥ Include BB HINER

£ include TURUET G R AT, FIRESS HIIMZAF I BRAR A2, IR s Workspace B¢ File
System 1 H Ji5 W] 78 55 H A 45

8.14. E W HA HRAZ

A AT RERDYHE KN, B> e B Aok, il 8-6, W sl ZLHEH A Uy 1A el bw
WRBEEAE H
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]
type filter text Settings vor
Resource
~
Builders X . . - -
v C/C++ Build Configuration: |Debug [ Active ] ~  Manage Configurations...
Build Variabl
f;;l;x;gmmt ® Tool Settings # Toolchains B Devices 0 Container Settings # Build Steps " Build Artila(tE
i
Settings Name: RISC-V Nuclei GCC (riscv-nuclei-elf-gcc)
Tool Chain Ec | arcpitecture: RISC-V v
w C/C++ General
Prefix: riscv-nuclei-elf-
C/C++ Langu e gl A o g (A
: ) stz 7] Beb il ) £
Code Analysi Suffix: [' lt&t J\l = 'hiﬁ/j* r I
Documentati C compiler: acc
File Types c iler
Formatter ++ compiler g++
Indexer Archiver: ar

Language M: Hex/Bin converter: |objcopy
Paths and Syi
Preprocessor
Profiling Cate Size command: size

Listing generator: | objdump

Linux Tools Path Build command:  make
MCU
Project Natures

Project Referenc
Run/Debug Set! Toolchain path: ${eclipse_home}\toolchain\gcc\bin

Remove command: | rm

Task Repository (to change it use the global or workspace preferences pages or the project prope
Task Tags Build tools path: | ${eclipse_home}\toolchain\build-tools\bin
Validation (to change it use the global or warkspace preferences pages or the project prope
WikiText
[v] Create flash image
[] Create extended listing
[v] Print size
< > v

@ Cancel
8-6 EoRkEAE H
8.15. JFRIR T REKE RIS

ARG RITF AR T B AR NS, SR PV s, VI EM A USB3.0 #21, Wi
MIRESBLIT A, R3S [FINRs USB #% 3 E N 3.0.

8.16. Linux #3 T2 A {4 A Nuclei Studio

R T E L H P [EEHE B Nuclei Studio (AEE) , H P #Ei217T Nuclei Studio B & 6 B $T
TSR] “Window->Preferences” . 7E3E T E& N =AM )T

® #TJf “MCU->Global OpenOCD Path” , “Executable” #i A\ “openocd” , “Folder”
N “${eclipse_home}/toolchain/openocd/bin” .

® {IJf “MCU->Global QEMU Path” , “Executable” #i A\ “gemu-system-riscv32” ,
“Folder” #i A\ “${eclipse_home}/tools/qemu” .

® FTJF “MCU->Global RISC-V Toolchains Paths” , “Default toolchain” %+ “RISC-V
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Nuclei GCC” , “Toolchain folder” #i A\ “${eclipse_home}/toolchain/gecc/bin” .
B )5 st “Apply and Close” fRAFI 5% I B i &

8.17. R EHBHRFHBHNEO

REER R REAE S E BT VU PN SR L, W 8-7, o COM g 5 BRI £ 4T
B, nf DM & A T35 T RIEREETHER, HEAEAZEEH COM %55/ &
o

v § %0 (COMFLPT)
f§ USB Serial Port (COM36)
i USB Serial Port (COM37)
> B B
> O it
> O mEs
> O BF
i ARERBAIRE
> B RiFgE
> ¥ Al
> 8 EVRBLRE
> W BEE. YUIHIRRIZHIES
> @ BIFEIEEHRE
v § EESRTRLRHES
¢ Intel(R) USB 3.1 BT¥ @E#H 132488 - 1.10 (Microsoft)
USB Composite Device
USB Composite Device
USB Serial Converter A
USB Serial Converter B
USB tREE4:28(USB 3.0)
& SuperSpeed USB $E£538
B USB $E£:38

-@: - -@ |- -a:ha - -a

8-7 WA B B AR R AN R

9. Nuclei Studio %

— & IE LR, WR Nuclei Studio %A KA AES), Nuclei Studio 2 TAERT LA R
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BWECH I GNU T H 8% P A A7 5 T 2 AN T+ 2% IDE Plugins )5 20K 58
9.1. GCC/OpenOCD % T B4k 2z

Nuclei Studio 44 T HEE4E %7t IDE &8, T HEEA7HE NucleiStudio_IDE_ XXX {4
JeN, #424: NucleiStudio_ IDE_XXX\NucleiStudio\toolchain. IDE BRi\{# FH & 4% ) T A
B, LI AEFRD) “toolchain” ML F¥, M IDE A% TFE /G A 75 Bt AT T 5 BE A AH O i
=

T CREET N EE~t IDE B, Brel)a s 2 - Fah Tk T REE, TR 07k

T

MR EE T GCC 5i# OpenOCD AN EE, SRIGIECRABMS B I N #HiaH
WA GCC 5¢# OpenOCD.

B ¥ GCC #i# OpenOCD [N A& HlBIX NS T, BPrT 52/ IDE T 55 1 5 37,
IDE [ i) T B A% ()R A 510 54 7E ReadMe.txt F1, W18 9-1 Fiom. 1ERE: ERE gee bt
FERX — % B0 47 A28, B 5 (RE bin ST BT 2 2 B e 11 |
3, AN EA HA ST AR

build-tools 2020/7/30 10:35 prgl=>c

gcc 2020/7/30 10:3 AL

openocd 2020/7/30 10:35 prgli=>
— ReadMe.txt 2019/9/25 13:48 A RY

9-1IDE T H#Es42
9.2. IDE Plugins 7%
Nuclei Studio 3 #f IDE WTELTHE, HRRATTF .
B 9-2, FIIF LRI, ERPEFER “Help > Install New Software”

B K 9-3, fidh “already installed” #7771 £ 2235 FL i .
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B 0K 9-4, #%FF “Nuclei Studio” , T “update” B n] H 25 5 AE 28 557

€ CPDE - 1_helloworld/application/main.c - NucleiStudio
File Edit Source Refactor Navigate Search Project Run RV-Tools Windaw|

&|[%[m| #Debug  ~ [ 1 helloworld debug_~ | ‘=~ 5 R PRI R
 Debug ' Project Explorer E%|# =0 2main © ;_‘:"’ﬁ“"‘""“ " - Variables i ress if
« &1 helloworld 62 | ¥ >earc = gelr
& Binaries 63 Shaw Contextual Help Neme Type Value
 Includes vt Show Active Keybindings.- Ctrl+Shift+L
« & application p « Tips and Tricks.
4 main &7 @ Report Bug or Enhancement..
= Debug 68 Cheat Sheets
: Pt
= nuclel sdk ‘e @ Eclipse User Storage >
1_helloworld_debug_openocd launch 7% | % Perform Setup Tasks..
72 Check for Updates
’; < Install New Softwal
4 Telipse Marketplace
76 @ About NucleiStudio
77 Contribute
76 mIsa_chars[IndextE] = VeI
88 printf(*MISA: RVEs\r\n", misa_chars);
51}
_51
53-int main{void)
84
85 srand(__get_rv_cycle() | _get rv_instret() | _RV_CSR_READ(CSR_MCYCLE));
56 uint32t rval = rand();
57 ru_csr_t misa = __RV_CSR_READ(CSR_MISA);

printf("MISA: @x¥lx\r\n", misa);
print_misa();

for (int i =@; 1< 28; i +4) {
printf("%d: Hello World From Nuclei RISC-V Pracessor!\r\n”, i);

return @;

O Console T xeculables @ c ax% BRREEE =D
<terminated> 1 helloworld_debug_openocd [GDB OpenOCD Debugging] openocd.exe

(3295) hpmcounter3eh (/32)

(3296) hpmcounter3ih (/32)

(3922) mvendorid (/32)

(3923) marchid (/32)

(3924) mimpid (/32)

(3925) mhartid (/32)

(4161) priv (/8)

/1 helloworld/application/main.c

9-2 T LA AT T
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@ Install | X
Available Software _)
) -
Select a site or enter the location of a site.
3 a N
Work with: |l e K ~ Add... Manage...
type filter text Select All
Name Version Deselect All
[ ]@ There is no site selected.
Details
Show only the latest versions of available software Hide items that are already installed
Group items by category What isfalready installed?
[]Show only software applicable to target environment
Contact all update sites during install to find required software
@ < Back Next > Finish Cancel

9-3 fIFC A St
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@ NucleiStudio Installation Details

type filter text

Name
i GCov Integration
- GDB Tracepoint Analysis
(@ Git integration for Eclipse
@ GNU MCU C/C++ ARM Cross Compiler
G GNU MCU C/C++ CodeRed Debug Perspective
[ GNU MCU C/C++ Generic Cortex-M Project Template
@ GNU MCU C/C++ J-Link Debugging
G GNU MCU C/C++ OpenQOCD Debugging
[ GNU MCU C/C++ Packs (Experimental)
@ GNU MCU C/C++ PyOCD Debugging
 GNU MCU C/C++ QEMU Debugging
@ GNU MCU C/C++ RISC-V Cross Compiler
@ GProf Integration
i@ Library Hover help for devhelp documentation
@ LTTng Kernel Analysis
@ LTTng Tracer Control
i@ LTTng Userspace Analysis
[ Marketplace Client

Installed Software Installation History Features Plug-ins Configuration

Version

7.0.1.2018091215...
4.1.0.2018091209...
5.1.0.2018091115...
2.6.4.2018093006...
1.1.2.2018093006...
1.4.4.2018093006...
4.3.4.2018093006...
4.3.3.2018093006...
2.2.2.2018093006...
1.3.3.2018093006...
3.3.3.2018093006...
2.8.2.2018093006...
7.0.1.2018091215...
7.0.1.2018091215...
4.1.0.2018091209...
4.1.0.2018091209...
4.1.0.2018091209...
1.7.2v20180829-...

Id

org.eclipse.linuxtools.gcov
org.eclipse.tracecompass.c
org.eclipse.egit.feature.grc
ilg.gnumcueclipse.manage
ilg.gnumcueclipse.coderec
ilg.gnumcueclipse.templai
ilg.gnumcueclipse.debug.¢
ilg.gnumcueclipse.debug.¢
ilg.gnumcueclipse.packs.fe
ilg.gnumcueclipse.debug.¢
ilg.gnumcueclipse.debug.¢
ilg.gnumcueclipse.managg
org.eclipse.linuxtools.gpro
org.eclipse.linuxtools.cdt.li
org.eclipse.tracecompass.|
org.eclipse.tracecompass.|
org.eclipse.tracecompass.|
org.eclipse.epp.mpc.featur

@ Valgrind Tools Integration

<

7.0.1.2018091215...

@ Mylyn Context Connector: C/C++ Development 5.20.0v20180905... org.eclipse.cdt.mylyn.featu
@ Mylyn Context Connector: Eclipse IDE 3.24.2v20180905... org.eclipse.mylyn.ide feat:
@ Mylyn Context Connector: Team Support 3.24.2v20180905... org.eclipse.mylyn.team fei
@ Mylyn Task List 3.24.2v20180905... org.eclipse.mylyn feature.
i@ Mylyn Task-Focused Interface 3.24.2v20180905... org.eclipse.mylyn.context
@ Mylyn Tasks Connector: Bugzilla 3.24.2v20180905... org.eclipse.mylyn.bugzilla.
4 Mylyn WikiText 3.0.25.201806201... org.eclipse.mylyn.wikitext
I 4+ Nuclei Studio 1.0.0 com.nucleisys.ide.feature.l
g RPM Tools 7.0.1.2018091215... org.eclipse.linuxtools.rpm.
@ TM Terminal 4.5.0.2018091014... org.eclipse.tm.terminal.fea
i@ TM Terminal Serial Connector Extensions 4.5.0.2018091014... org.eclipse.tm.terminal.cor

org.eclipse.linuxtools.valgr
L

>

OpenOCD

provided in Nuclei Studio

1. Brand-new Nuclei Studio, deeply integrated with Nuclei SDK,Nuclei RISC-V Toolchain and Nuclei

2. New Nuclei SDK Project template wizard for GD32VF103 and Nuclei HummingBird Evaluation SoC is

@ Update... Uninstall...

Properties

Close

9-4 %% “Nuclei Studio” H¥#r

10.f#F QEMU 15 B

TR A< ) Nuclei Studio #4 7 QEMU, Y £f GD32VF103 flith K4 £ %1 Core 1 LFESZHL

i BRI A, X B PL RVSTAR T AN,

FIEHTSCH N A H i — 4 RVSTAR L#2, X9 DL helloworld T AHI, BATHE 12N
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helloworld £ T.#&.

FHiiEdf TR, #%# “Debug As -> Debug Configurations” F1 TR &% B # % . e
10-1, 7E#E % “GDB QEMU Debugging” FiHA “qemu” JEZ&H& Bk, HANTTREN
“helloworld” , FrLAitAbik# “helloworld_debug _qemu” , )5 fiidit FJ5H) “Debug”

VAR LI RIE W

& Debug Configurations 0 X

Create, manage, and run configurations 'ﬁ\

CERBXBY ¥ Name:‘hel\owor\didebugiqemu |
type filter text | Main % Debuggeﬂ [ 3 Startup] s Source} =] Common] 7 SVD Path]
] C/C++ Application )
[ C/C++ Attach to Application it
& C/C++ Container Launcher ‘hel\owor\d Browse...
€1 C/C++ Postmortem Debugger || C/C++ Application:
C/C++ Remote Application ‘Debug/he\\owor\d.elf
i C/C++ Unit : :
# Debug Adapter Launcher Variables.. = Search Project... Browse...
@ DSF PDA Application Build (if required) before launching
= GDB Hardware Debugging Build Configuration: Select Automatically v
1 GDB Jumper Debugging
~ [ GDB OpenOCD Debugging (O Enable auto build (0 Disable auto build
© helloworld_debug_openocc (® Use waorkspace settings Configure Workspace Settings...
=1 GDB PyOCD Debugging
+[=1GDB QEMU Debugging
[l helloworld debug gemu
-Link Debuggin
@ Launch Group
< >
Filter matched 17 of 17 items Revert Apply

@
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& Debug Configurations

Create, manage, and run configurations

CedEX | B Y - Name: |he||0w0r|d_debug_qemu
|| Main | %% Debugger = Starlupw By Source\l =] Qommon} & SVD Patlﬂ
[E] C/C++ Application QEMU Setup ~
[E] C/C++ Attach to Application Start QEMU locally
[E] C/C++ Postmortem Debugger -
[E] C/C++ Remote Application Executable path: |${qemuyath}ﬁ{qemu_executable_32} Browse... | Variables...
‘% Debug Adapter Launcher Actual executable: |G:\woke\NucleiStudio\test.202109\NucleiStudio\\tools\qemufqemu-system-riscv32.exe
@ DSF PDA Application fto ch i preferences pages or the project properties page)
[£] GDB Hardware Debugging L .
» [£] GDB OpenOCD Debugging Machine Bit: gemu-system-riscv32 ~
v [t] GDB QEMU Debugging Board name: gd32vf103v_rvstar ~
[©] helloworld_debug_gemu
2 testo debu_g qerm: Muclei RISC-V Core: | N205 ~
[&] test1_debug_gemu Download: flashxip ~
[] test123_debug_gemu
- - GDB port: 1234
[E] test2_debug_gemu = \—1
[E] test3_debug_gemu More options: -serial stdio -nodefaults -5
[€] test5_debug_gemu
[E] test6_debug_gemu
(] test7_debug gemu Enable Arm semihosting Do not open graphic windows
[] test8_debug_gemu .
5 testd_debug_gems Command line: |he||0w0r|d
= testga_debu;_qemu ] Allocate console for QEMU [JExtra verbose
[E] test91_debug_gemu GDB Client Setup
[£] GDB SEGGER J-Link Debugging
Executable name: |${cross_prefixjgdb${cross_suffix} Browse... | Variables...
i Launch Group P 9 =
Actual executable: |riscv—nuc|ei-e|f—gdb |
Other options: | |
Commands: set mem inaccessible-by-default off
set remotetimeout 250
set arch risowrv32
v
Revert Appl
Filter matched 37 of 37 items = BEY
@

& 10-1 %4+ QEMU #4747 E iR

QEMU [ £4HfC & 71, #r1% T Machine Bit. Board name. Nuclei RISC-V Core. Download
I, H PR LR B QEMU 7 H 2 X E .

B Machine Bit QEMU 1] LUJj & 32 il 64 A R &

B Board name %%} A[E ) Board B A /M M AL E

AR N E RSO G RBHOM KA, REURBHRE I, AR sl e A2 A i sl A

T 107



R
NUCLEI

B Nuclei RISC-V Core QEMU U4 X #7410 nuclei KZH M AHIEI S, FHFohps®

W SCFFEZ B E SRS Nl 7SR CPU A5 (1S i

900EF

GIIE=]|

300EF

2007

NERE] NXERE] UXRE]
(326E5E4) (64{EEE) (64{irZE4, Linux)

| NS00 || NS0OF ||N900FD| | NX900 ||NXBOUF|F\IXQDDFD| | UX900 ||UXQDOF“JXQDOFD|

| NBOD || NBOOF ||N600FD| NX600 || NXG0OF | NX500FD ‘ UX600 ”UXGDUFHJXGDDFD‘

N200 || N200E
N203 || N203E
N205 || N205E

B Download QEMU fjj 5 1 AN[A] T #ehi 3

%VE: 2021.09 ] Nuclei Studio %} 2 BT A Nuclei Studio 1% /) LFEH) gemu #4332

ke 10-2 o, DT ECORBITE S B R T sE e Al 1R, e, A DT BN S AT LR A
Console T &% . #fFas il REAT AL/ RSLHLM s, J& T IEFIG.

AN PITIR A BB ER BT, RSP R TIRA, AMSAERR . S Sl e A SO 2 A iR sl A
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@ NucleiStudio_workspace - helloworld/application/main.c - NucleiStudio IDE

File Edit Source Refactor Navigate Search Project Run RV-Tools Window Help

&|[% [®] 5Debug  ~ Ehelloworld debug g~
# Debug & Project Explorer = &l
~ [ helloworld_debug_qemu [GDB QEMU Debugging]
~ & helloworld.elf [1]
« # Thread #1 1 (CPU#D [running]) (Suspended : Breakpoint)
= main{) at main.c88 DxB001b1c
£ gemu-system-riscv32 exe
2 riscy-nuclei-elf-gdb

WBvTO AT SEFv SDumoE i AL WIS )

4 main.c =

if (misa_bits.b.p) {
misa_chars[index++] = '#';

}
if (misa_bits.b.t)
misa_chars[indexs++] = 'T';

if (misa_bits.b.u) {
misa_chars[indexs+] = 'U';

if (misa_bits.b.v) {
misa_chars[index++] = 'V';

}

if (misa_bits.b.x) {
misa_chars[index++] =

}

misa_chars[indexs+] = "\8';

printf("MISA: RVEs\r\n", misa_chars);

main(void)

srand(__get_rv_cycle() | _get_rv_instret() | __RV_CSR_READ(CSR_MCYCLE));
vint32_t rval = rand();
ry_csr_t misa = _RV_CSR_READ(CSR_MISA);

printf("MISA: @xX¥lx\rin", misa);
print_misa();
for (int i = 8; § < 20; 1 ++) {
printf("%d: Hello World From Nuclei RISC-V Processorl\rin”, i);

return 8;
100 }

101
102

S Console = 7 Problems © Executables ®Debugger Console 0 Memory
helloworld_debug_gemu [GDB QEMU Debugging]

Muclei SDK Build Time: Dec 29 2028, 17:18:51

Download Mode: FLASHXIP

CPU Frequency 126523411 Hz

10-2QEMU {5 5 il ik At i

: misa
Details:@
Default:@
Decimal:@

Hex:0x@
Binary:@
octal:@

Type
uint32 t
nv_esr t

>

Update RPM packages proposal list o

- 9 x
o @ EfE
Registers §eln=1=n0
Name Value Descri ~
~ ¥ Genera Gener,
‘zer0 0

ra  DxB000268 < st..
“sp  0x20004fb0
gp 020000860
‘tp Dx0

0 134225212
115

0
ifp  0x20005000
s 0
iad 0
al 0
ia2 28
a3 536871036
iad B
a5 771751936
Pab 31
al 0
is2 0

<30
< >

Hame : sp

Hex:0x20004fbe
Decimal:536891312

Octal: 84880847660
Binary:100200800008000100]
Default:ex20884fbe

EeEEseovzr-no

15 BisAT e 505 BRI 24, 4 RVSTAR T.FEi%E# “Run As -> Run Configurations” ,
HE L “GDB QEMU Debugging” T H “qemu” JEHHWEILED. &EH )5 Ad “Run” ,
] LAfEFEHI & (Console #2) F Riz47THIFT ElfrH -
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